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In This Book

This book introduces your system and provides a step by step guide on how to
begin using your system. It contains the following chapters described below:

Chapter 1: Introducing Your System

Describes the two main ways of using your system.

Chapter 2: Familiarizing Yourself with Your Computer

Provides a hardware overview.

Chapter 3: Familiarizing Yourself with Your Computer Peripherals

Provides an overview of the disk drive, the Data
Communications and Terminal Controller (DTC) and the
Uninterruptible Power System (UPS).

Chapter 4: Getting Your System Ready for Use

Describes how to set up external disk drives, terminals and
printers and how to boot up the system.

Chapter 5: Using and Maintaining the Tape Drive

Describes how to prepare a cassette for your tape drive, load
and unload a cassette, how to make tapes and how to maintain
and store your cassette.

Chapter 6: Getting Started with HP Easytime/iX

Describes how to start HP Easytime/iX and the basic skills
that you need to use the menus e�ectively. This is a good
chapter to start with if you are new to the HP 3000.
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Chapter 7: Performing Tasks with HP Easytime/iX

Describes many of the tasks that you need to monitor and
manage printing, �les, jobs, sessions, console messages, and
backups on your system.

Chapter 8: HP Easytime/iX Reference

Provides information about console messages and requests,
error messages, function keys, wildcard character sets, and �eld
de�nitions for each HP Easytime/iX screen.

Appendix A: Preparing Additional Software Products

Describes additional steps to perform before using speci�c
products.

Appendix B: Con�guring Your UPS

Describes how to con�gure your UPS if the original
con�guration is lost.

Appendix C: UPS Console Messages

Describes the messages that a user will see after a power
failure.

Appendix D: Declaration of Conformity
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Related Manuals

Getting Started is the second book in a set of �ve manuals that includes the
following:

Understanding Your
System (B3813-90001)

If you are new to computers, this is a good place to
start. It provides an introduction to what computers do
and how they do it.

Getting Started
(B3813-90003)

Familiarizes you with your computer and computer
peripherals. It also explains how to get your system
ready for use, how to use and maintain your tape drives
and how to communicate with your system using HP
Easytime/iX.

Task Reference
(B3813-90009)

Describes how to communicate with your system using
MPE/iX commands. This book also includes a chapter
on how to get more information on your system, a
chapter on troubleshooting and a glossary.

Commands Reference
(B3813-90011)

Provides a detailed explanation of each MPE/iX
command.

New Features of
MPE/iX: Using the
Hierarchical File
System (32650-90351)

Describes the changes to MPE/iX as of Release
4.5 and 5.0, which enhanced MPE/iX to make it
\POSIX-compatible." The book also describes the
features of the hierarchical �le system.
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Note The MPE/iX operating system has been enhanced as of Release
4.5 and 5.0 to include additional features that include POSIX
compatibility and the hierarchical �le system. The hierarchical
�le system is tree structured and can contain �les at many
di�erent levels. This organization provides a special kind of �le
called a directory. Instead of holding data, directories contain
lists of �les and pointers to those �les.

For more information on POSIX and the hierarchical �le
system, refer to the book, New Features of MPE/iX: Using
the Hierarchical File System (32650-90351), included in this
documentation set. This book includes an overview of the
following enhancements of MPE/iX as of Release 4.5 and 5.0:

Open systems environment

Hierarchical �le system (HFS)

Expanded �le naming syntax

New and enhanced commands and utilities

MPE/iX Shell and Utilities

MPE/iX Developer's Kit
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Introducing the HP 3000 Series 9X8LX

Hewlett-Packard's HP 3000 Series 9X8LX computer system for the multiuser
environment combines o�ce computing with mainframe power. The system
is designed to be used in a standard o�ce setting without the stringent
environmental controls of the typical computer room. Its compact size
accommodates a number of o�ce con�gurations.

Typically, the system consists of the following components:

the main computer that �ts comfortably alongside a desk or table

the system console connected to the computer for system activities

an optional cabinet containing additional disk and tape drives for extra data
storage

the data communication and terminal controller, also called the DTC, that
enables you to connect multiple terminals and printers to the system

The external uninterruptible power system, also called the UPS, that can
provide up to 15 minutes of battery backup power to the computer system.

terminals or PCs set up on each user's desktop and connected to the DTC

various styles of printers conveniently located for easy access by several users
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Introducing Your System

Your HP 3000 Series 9X8LX System

Your HP 3000 Series 9X8LX system is one in a family of computers renowned
for reliability and performance. You can communicate with your system
through a set of screens and menus called HP Easytime/iX or through a set of
commands known as MPE/iX commands.

What Is HP Easytime/iX?

HP Easytime/iX is an easy-to-use program through which you can
communicate with your HP 3000 computer. Based on a system of pull-down
menus, HP Easytime/iX guides you with descriptive phrases through the
day-to-day tasks that you need to do your job, whether that means managing
system resources, starting a job, printing a report, or sending a message to
another user on the system.

Whether you are the person who manages the system (in this documentation
set, this role is referred to as system administrator) or someone who only
uses applications on it, HP Easytime/iX provides easy methods or several
tasks. The system administrator manages the system in many ways such as
creating accounts and users, setting passwords, establishing schedules for
backups, and replying to requests. Some of these tasks can be done through
HP Easytime/iX.
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For example, HP Easytime/iX screens provide ways to inform users of backup
schedules, a system administration task. The screens also provide ways for all
users to send messages to each other, or to the person operating the console.
HP Easytime/iX helps in performing both system administration tasks and end
user tasks.

Here are just some of the tasks that you can perform with HP Easytime/iX:

print, copy, rename, delete, and store �les

review and manage �les waiting to be printed

start and delete jobs

show and delete sessions

send messages to other users

review messages and reply to requests from the system

perform full and partial backups

access an extensive online Help Facility

sort and display information to meet your special needs

What Are MPE/iX Commands?

All of the tasks that you can perform with HP Easytime/iX you can also
perform by using one or more direct MPE/iX commands. The commands that
you enter directly do not appear as a choice in a menu. You type them at a
prompt on the screen and often get a message from the system showing that it
received your instructions.
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The online Help Facility

In addition to your documentation, MPE/iX provides an extensive online Help
Facility that includes a description of every MPE/iX command, its parameters,
and an example of its use.

The quick reference cards

HP Easytime/iX Quick
Reference

This card provides a brief reference for
important skills and tasks.

MPE/iX Day-to-Day Tasks This quick reference for MPE/iX guides you in
�nding the commands that you might use most
often.
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Printing Conventions for this User's Guide

This convention Means this

italic text A book title, emphasized text, or text
that you must supply, such as the name
of a �le.

underlined text Text that you type exactly as shown.
For example, type

:SHOWME

computer text Text that appears on the computer
screen.

NNNNNNNNNNNNNNNNNN
Shaded Represents a push button or function

key label, such as
NNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Field Help .

�Key� Indicates a key on your keyboard, such
as �Return�.

The descriptions of MPE/iX commands, which use conventional MPE/iX
syntax, require more detailed conventions. Look in the book, Commands
Reference - HP 3000 Series 9X8LX (B3813-90011) for these.
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2

Familiarizing Yourself With Your Computer

Hardware Overview

Hewlett-Packard's HP 3000 Series 9X8LX computer systems for the multiuser
environment combines o�ce computing with mainframe power. Typically, the
system consists of the following components:

the main computer that �ts comfortably alongside a desk or table

the external uninterruptible power system, also called UPS, that can provide
up to 15 minutes of battery backup power to the computer system.

the system console used primarily by the system manager to perform system
related tasks

the data communication and terminal controller, also called DTC16iX
(J2062A), that enables you to connect multiple terminals and printers to the
system.

an optional cabinet containing additional disks and tape drives

various styles of printers conveniently located for easy access by several users

terminals or PCs set up on each user's desktop and connected to the DTC
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To familiarize yourself with the computer

The Computer
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You should take some time to study the front of the computer. The following
illustration shows the front panel of the computer.

Computer Front Panel

The front of the computer. All of the switches and indicators on the computer
are located along the top, in the front of the computer as shown in the �gure
above.
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ON/OFF switch: Controls the DC power (not the AC power from the wall
outlet) for the computer, the internal disk drive, and internal tape drive. Once
the computer has started, you should turn this o� only as part of the shutdown
procedure.

Caution The OFF part of the front panel switch only disconnects the
DC power from the inside of the computer cabinet. AC voltage
is still present at the computer power supply. The AC power
can be removed only by unplugging the power cord.

Run: (Operating State Indicator). This green light indicates that the computer
is running normally. It can work in conjunction with the attention light.

Attention: (Operating State Indicator). When the yellow indicator light is on
something other than normal operation is occurring, but no fault has occurred.
For example, testing, initializing or system shutdown.

Fault: This orange light indicates that a fault exists in the computer.

Remote Enabled: When this yellow light is on, it indicates that remote access
through a modem port is enabled, allowing outside access to the computer.
This is useful if remote support is desired. When this light is o�, the remote
access is disabled or denied.
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Tape Drive

Figure 2-1. Tape Drive (3.5-inch DDS)

Cassette Light and Drive Light: These lights indicate the states of the tape
drive. See the Interpreting Tape Drive Indicator Status Lights section at the
end of this chapter.

Cassette Slot: Here you insert and retrieve the DDS tapes needed for storing
information onto tapes.

Cassette Unload Button: This button stops any tape operation, rewinds the
tape and ejects the cassette from the tape drive.
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Interpreting Tape Drive Indicator Status Lights

The various status states that you see displayed are shown in the following
table.

Table 2-1. HP 3.5-inch DDS Tape Drive

Cassette Light Drive Light Condition

No Cassette States

O� O� No cassette loaded, or power is o�.

Flash Yellow Flash Yellow Self-test in progress.

On Green Flash Green No cassette; tape drive is active.

Write Enable States

On Green On Green Cassette loaded; tape drive online.

On Green Flash Green Cassette loaded; tape drive active.

Pulse Green Pulse Green Loading, unloading, or ejecting cassette.

On Green O� Tape drive o�ine.

Write Protect States

On Yellow On Green Read-only cassette loaded; tape drive online.

On Yellow Flash Green Read-only cassette loaded; tape drive active.

Pulse Yellow Pulse Green Loading, unloading, or ejecting cassette.

On Yellow O� Tape drive o�ine.

Error States

On Green Pulse Green/Yellow Caution1 (media warning).

On Yellow On Yellow Moisture detected,2 or no termination resistors.

Pulse Yellow On Yellow Fault3.

1 This occurs during writes where an excessive number of read-after-write
errors occur and persists until the cassette is unloaded.
2 The termination resistor problem occur only at power-on time, and the tape
drive appears to have hung during self-test.
3 Indicates a failure of the DDS �eld replaceable unit.
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3
Familiarizing Yourself With Your Computer
Peripherals

To familiarize yourself with the console

The console is an ordinary terminal that has a special purpose. You can locate
the switches, adjusting knobs, and connectors of the console in the following
illustration.
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Computer Console Back and Front Views

1. port 1, datacomm connector to the computer (back)
2. port 2, printer connector (back, not used for this computer system)
3. keyboard cable connector (back)
4. power cord connector (back)
5. power ON/OFF switch (front)
6. brightness control (front)
7. contrast control (front)
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To familiarize yourself with the external disk drive.

The external disk or disks, depending on how many you ordered, come
mounted in a disk cabinet. To familiarize yourself with the external disk
cabinet the following illustration shows the location of the switches, indicators,
and connectors for the disk cabinet (also known as a disk drive cabinet).

Disk Drive Cabinet Front and Back View

1. power on indicator (front) 3. bottom SCSI connector (back)
2. power receptacle and ON/OFF switch

(back)
4. top SCSI connector (back)
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The �gure above shows an external disk cabinet containing three disk drives.
To determine the number of disk drives in your external disk cabinet, count the
indicator lights (located on the right side of each disk drive).
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To familiarize yourself with the DTC 16iX (J2062A)

As a part of your new computer, you received at least one box containing a
Data Communications and Terminal Controller (DTC). The DTC 16iX allows
terminals, PCs, and printers to use the computer and be used by the computer.

Front Panel Display

DTC 16iX Front Panel

FAULT only active when there is a problem.

ACTIVITY a �xed light when the DTC 16iX is fully operational and
running without a problem. A ashing light indicates software
uploaded, download or a self-test in progress.

LINE ON stays lit when the power is on.

Refer the manual that accompanies the DTC 16iX for more details on
hardware operation.
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DTC 16iX Back View

DTC 16iX Back View

1. Junction Panel Connectors 4. ThinLAN Connection
2. Diagnostics port 5. Power Cord Connection
3. AUI Port
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To familiarize yourself with the UPS

The uninterruptible power system (UPS for short), provides up to 15 minutes
of battery backup for your system processor.

UPS Front Panel

UPS Front Panel
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The switches and indicator lights on the UPS front panel

The following table describes the switches and indicator lights on the front
panel of the UPS.

1. AC Output A green light|indicates that normal power (AC) is
being supplied to the receptacles in the back.

2. Battery Power A yellow light|indicates the unit is supplying power
during abnormal power (AC) conditions.

3. Attention A yellow light|indicates unit needs attention. This
indicator light, in conjunction with the audible alarm,
can have several meanings:

Light ON:

Charger fail: the internal batteries will not charge to
capacity.

Overload shutdown: Excessive overload causes the
unit to shutdown.

System fail: the unit has failed its calibration selftest.

A ashing light indicates an overload condition. With
too much equipment connected to the unit, the light
will ash once-per-second and sound an audible
alarm.

4. Silence Alarm/Test A switch|if the unit is supplying power during
abnormal AC conditions, an audible alarm sounds,
pressing this switch silences this alarm. The TEST
portion of this switch can be used to switch the unit
from AC operation to battery operation under
controlled conditions.

5. Output On/Output O� A switch|controls the output receptacles in the back of
the unit.
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Audible alarm The audible alarm is located inside the unit and is used
in conjunction with the Attention light and the Test
switch. There are three conditions that activate the
audible alarm:

1. Pushing the Test switch

2. AC power fail and unit switches to battery power.

3. Attention light comes on. This could be for an
overload condition or a low battery warning indicating
two minutes until battery depletion.

The beep sequence for the alarm is based on a half (0.5)
second interval timed at 10 seconds per sequence. For
example, a one beep alarm sounds for 0.5 seconds and is
o� for 9.5 seconds, then repeats. A three beep alarm
sounds three beeps (of 0.5 seconds on, 0.5 seconds o�)
then o� for 7 seconds, then repeats.

Familiarizing Yourself With Your Computer Peripherals 3-9



UPS Back View

Figure 3-1. UPS Back View

1. Input connector There is one input receptacle to plug the unit into an
appropriate wall outlet for AC power.

2. Output connector There are four output receptacles that supply AC power
or battery power.

3. UPS Port A 9-pin RS-232 connector for communication to a
computer.

4. Safety Fuse A time delay 10 amp safety fuse.
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Configuring Your UPS

In most cases, your Hewlett-Packard representative will con�gure your UPS
when they install your system. If you should need to recon�gure, for example,
if you reinstall your system, refer to Appendix B, Con�guring Your UPS.

UPS Console Messages

If you lose power and the UPS is activated, you will see status messages on
your console. For a detailed description of these messages, refer to Appendix C,
UPS Console Messages.
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4

Getting Your System Ready for Use

Note Your Hewlett-Packard representative is responsible for the
installation of your HP 3000 Series 9X8LX system. The
following procedures assume that your system is at the point
where the fundamental operating software is starting and that
your system is waiting for your response to the ISL> prompt.

To list your system hardware

Before you start your system, you may want to use the MAPPER utility. Once
initiated, MAPPER displays a user interface that gives you information about
your disk drives, memory, processors and co-processors and allows you to
modify any information that you need to change. To run MAPPER from the
ISL prompt:

1. Type the following at the ISL prompt to get an ODE prompt:

ISL> ODE

2. Type the following at the ODE prompt to get a MAPPER prompt:

ODE> MAPPER

3. At the MAPPER prompt type:

MAPPER> RUN

To exit MAPPER after you modify or accept the information displayed, you
must exit out of MAPPER and ODE to get back to the ISL prompt. For
example:

1. MAPPER> EXIT
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2. ODE> EXIT

3. ISL>

Note To use MAPPER after you have started up your system, you
must �rst stop all system activity and shut the system down,
for example, at the system console prompt:

: [ [CTRL]] A

=SHUTDOWN

Once the system issues the �nal shutdown message, transfer
control by entering:

[ [CTRL]] B

If this reply does not work, initiate a hard reset by entering:

CM> RS

Then, at the ISL prompt, proceed as above (Step 1) to run
MAPPER.

To start your system from the ISL prompt

1. Type the following at the ISL> prompt:

ISL> START NORECOVERY �Return�

Note If you have not con�gured your HP 3000 Series 9X8LX system,
use the default con�guration group for your system, for
example type:

ISL> START NORECOVERY GROUP=CONFIG9X8 �Return�

2. After a few minutes, you are prompted to con�rm the date and time. If you
do not respond within 15 seconds, the system accepts the displayed date and
time by default and continues with the startup process. If the date and time
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are not correct, respond accordingly. Enter the time in 24-hour format (for
example, 5:00 pm is entered as 17:00).

Note Do not be alarmed if you inadvertently miss the system's
time-out to change the date and time. You will be given
another opportunity to change the date and time when you
reboot the system.

Your system will display some warning messages on the console telling you
that uncon�gured devices are attached to your system.

Do not be concerned. These messages are normal during your �rst boot up.
They appear during the �rst bootup because you have not completed your
�nal con�guration.

When the system is ready for you to proceed, a system prompt appears.
The typical prompt at this point is the colon (:). At this point, you are
automatically logged on to the system as OPERATOR.SYS and can begin
performing system management tasks such as con�guration and creating
user accounts.

To add external disk drives to the operating system

To con�gure your system and its peripherals, you must know what pieces of
equipment make up your system's set up. You can use MAPPER to �nd out
what is connected to your system. You can also ask your HP Representative or
refer to your Purchase Order to help you determine this.

If you have purchased any additional external disk drives, use the VOLUTIL
utility to de�ne and initialize them.

Note If you have NOT purchased any additional external disk drives,
skip to the next section entitled, To remove precon�gured
LDEVs from your system.

1. Log on as MANAGER.SYS:
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:HELLO MANAGER.SYS;HIPRI �Return�

2. At the system prompt, type the following to get into VOLUTIL:

: VOLUTIL �Return�

3. Use the VOLUTIL utility to identify each external disk drive separately.
Your system may arrive with either one or two internal disk drives already
precon�gured on your system. If you have one internal disk precon�gured,
use 2 in place of n in the following example when adding an external disk
drive to your con�guration.

If your system has two precon�gured disk drives, use 3 in place of n when
con�guring the external disk drive. Note that your internal disks always
count as the �rst disk drive and second disk drive, if the second one exists.

volutil: NEWVOL VNAME=MPEXL_SYSTEM_VOLUME_SET:MEMBERn LDEV=n �Return�

For example, to add an external disk drive to your system con�guration,
where there is one internal disk precon�gured, type the following:

volutil: NEWVOL VNAME=MPEXL_SYSTEM_VOLUME_SET:MEMBER2 LDEV=2 �Return�

4. The system displays a screen similar to the following each time that you
initialize an external disk drive. Con�rm that you want to initialize each
new member volume by responding to the prompt as shown:

d a

c b

volutil:NEWVOL VNAME=MPEXL_SYSTEM_VOLUME_SET:MEMBER2 LDEV=2

*Verify:Initialize new member volume

MPEXL_SYSTEM_VOLUME_SET on ldev 2 [Y/N]?y

Note:New member volume has been initialized on ldev2.

Using these procedure you can initialize up to three external disk drives, if
one internal disk drive is precon�gured on your system. You can con�gure
two external disk drives if your system is precon�gured with 2 internal disk
drives.
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5. To return to the system prompt (:). At the volutil: prompt, type:

volutil: EXIT �Return�

The system prompt should reappear.

To remove preconfigured LDEVs from the operating
system

Follow these procedures only if you have not purchased any external disk
drives.

1. At the system prompt (:), type:

:HELLO MANAGER.SYS;HIPRI �Return�

2. To get into the SYSGEN utility, type the following:

:sysgen confg9x8 �Return�

A screen similar to the following should appear:
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d a

c b

SYSGEN version E.00.00: catalog version E.00.00 TUE, SEP 28, 1993,

Copyright 1987 Hewlett-Packard Co. All Rights Reserved.

**warning** no NMCONFIG file in this configuration.

**warning** NMCONFIG.PUB.SYS is now the NMCONFIG file

** First level command **

io log (lo) misc (mi) spu (sp)

sysfile (sy)

basegroup (ba) keep(ke) permyes (pe) show (sh)

tape (ta)

clear (cl)(c) exit (ex)(e) help (he)(h) oclose (oc)

redo

sysgen>

3. To see how your system is currently con�gured, type IO at the prompt.

sysgen> io �Return�

A screen similar to the following should appear:

d a

c b

** IO configuration commands **

aclass (ac) adev (ad) apath (ap) avol (av)

dclass (dc) ddev (dd) dpath (dp) dvol (dv)

lclass (lc) ldev (ld) lpath (lp) lvol (lv)

maddress(ma) mclass (mc) mdev (md) mpath (mp)

mvol (mv)

clear (cl)(c) exit (ex)(e) help (he)(h) hold (ho)

oclose (oc) redo
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4. To get a device listing, type LD at the prompt.

io> ld �Return�

A listing similar to the following should appear:

d a

c b

LDEV: 1 DEVNAME: OUTDEV: 0 MODE:

ID: HPC2474S RSIZE: 128 DEVTYPE: D

PATH: 56/52.6.0 MPETYPE: 4 MPESUBTYPE

CLASS: DISC SPOOL

LDEV: 2 DEVNAME: OUTDEV: 0 MODE:

ID: HPC2474S RSIZE: 128 DEVTYPE: D

PATH: 56/52.5.0 MPETYPE: 4 MPESUBTYPE

CLASS: DISC SPOOL

LDEV: 3 DEVNAME: OUTDEV: 0 MODE:

ID: HPC2474S RSIZE: 128 DEVTYPE: D

PATH: 56/52.4.0 MPETYPE: 4 MPESUBTYPE

CLASS: DISC SPOOL

LDEV: 4 DEVNAME: OUTDEV: 0 MODE:

ID: HPC2474S RSIZE: 128 DEVTYPE: DISC

PATH: 56/52.3.0 MPETYPE: 4 MPESUBTYPE: 2

CLASS: DISC SPOOL

LDEV: 6 DEVNAME: OUTDEV: 0 MODE:

ID: HP2567B RSIZE: 66 DEVTYPE: LP

PATH: 56/52.8.0 MPETYPE: 32 MPESUBTYPE: 9

CLASS: LP LP1

LDEV: 7 DEVNAME: OUTDEV: 0 MODE:

ID: HPC1503B RSIZE: 128 DEVTYPE: TAPE

PATH: 56/52.0.0 MPETYPE: 24 MPESUBTYPE: 7

CLASS: TAPE DDUMP TAPE1

.

.

.

5. To delete LDEV 3 and LDEV 4 from the con�guration, type the following at
the IO> prompt:
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io> dd 3 �Return�
io> dd 4 �Return�

6. To check to see if these devices have been removed type the following at the
IO> prompt:

io> ld �Return�

A screen similar to the following should appear:

d a

c b

LDEV: 1 DEVNAME: OUTDEV: 0 MODE:

ID: HPC2474S RSIZE: 128 DEVTYPE: DISC

PATH: 56/52.6.0 MPETYPE: 4 MPESUBTYPE: 2

CLASS: DISC SPOOL

LDEV: 2 DEVNAME: OUTDEV: 0 MODE:

ID: HPC2474S RSIZE: 128 DEVTYPE: DISC

PATH: 56/52.5.0 MPETYPE: 4 MPESUBTYPE: 2

CLASS: DISC SPOOL

LDEV: 6 DEVNAME: OUTDEV: 0 MODE:

ID: HP2567B RSIZE: 66 DEVTYPE: LP

PATH: 56/52.8.0 MPETYPE: 32 MPESUBTYPE: 9

CLASS: LP LP1

LDEV: 7 DEVNAME: OUTDEV: 0 MODE:

ID: HPC1503B RSIZE: 128 DEVTYPE: TAPE

PATH: 56/52.0.0 MPETYPE: 24 MPESUBTYPE: 7

CLASS: TAPE DDUMP TAPE1

.

.

.

7. To keep your con�guration changes type the following at the IO> prompt:

:SYSGEN config �Return�

io> hold �Return�

io> exit �Return�
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sysgen> keep config �Return�

Purge old configuration (YES/NO)? YES �Return�

Keep configuration anyway (YES/NO)? YES �Return�

8. When you start (boot up) the system next time, you need only type the
START NORECOVERY command at the ISL prompt.

9. To return to the system prompt (:), when the sysgen> prompt reappears,
type:

sysgen> EXIT �Return�
:

Setting Up Your Terminals and Printers

Terminals and printers are connected to the computer through the data
communications and terminal controller (DTC). If you have a DTC 16iX, you
must perform the activities described here.

To get your terminals and printers to communicate to the system

Once the appropriate cables have been connected through the DTC 16iX in
your system set up, you must tell the system where to look for the DTC. This
location is known as the DTC station address, and is located either on the
front cover or back panel of the DTC box. You must input each LAN address
that you have connected in your system set up.

1. At the system prompt, log onto MANAGER.SYS:

:HELLO MANAGER.SYS �Return�

2. Run the NMMGR program:

:NMMGR.PUB.SYS �Return�

The Open Con�guration/Directory File screen is displayed.
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The Open Configuration/Directory Screen

3. NMCONFIG.PUB.SYS is the name required by the software. Verify that this
name is displayed in the Configuration file name �eld.

4. Verify that the name of the correct backup con�guration �le is in the
Backup configuration file name �eld. The default is NMCBACK.pub.sys.

5. Press the function key Open Config function key (�F1�).

If the con�guration �le you are opening does not exist, the following
message appears on the message line at the top of the screen:

Config files does not exist; press Open Config again to create it.

6. Press the Open Config function key again.

The following Main screen is displayed:
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The Main Menu

To �ll in the Main Menu:

1. Provide node name using the format: nodename.domain.organization.

Use the format nodename.domain.organization, where nodename identi�es
the DTC. If there is more than one DTC on the system, the nodename of
each DTC must be unique.

Note DTC name and DTC node nameare two di�erent �elds.
However, it is common to use the nodename part of the DTC
node name as the DTC name, for example:

DTC name = ALPHA

DTC node name = ALPHA.ACCTG.TEKLAB

2. Reply with N to the following prompts:

Are you using OpenView DTC Manager? N
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Do you have X.25 system-to-system or PAD connections? N

3. Press the Save Data function key (�F6�).

4. Press the DTS function key (�F1�).

The Host Con�guration screen will appear. This screen is used to con�gure the
Datacommunications and Terminal Subsystem (DTS) on the HP 3000. DTS
de�nes the interaction between the system and any \asynchronous" devices
such as terminals and printers.

Host Configuration Screen

To �ll in the Host Con�guration Screen:

1. The Local HP 3000 node name �eld displays the name of your local node.

2. The Link name �eld displays DTSLINK. Use this default.
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3. In the Physical path of LANIC �eld, enter slot number (default physical
path for Series 9X8LX is 60/6). Verify this number with your HP Service
Representative.

4. To save the information entered on this screen press the Save Data function
key (�F6�).

5. Press the Go to DTC function key (�F1�) to get the following screen:

DTC Configuration Selection Screen

6. Press the Go To DTC 16iX function key (�F2�) to get the following screen:
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To initiate the DTC 16iX Con�guration:

1. Enter the DTC's name in the \DTC name" �eld.

The DTC name can be up to eight alphanumeric characters, beginning with
a letter. The DTC name must be unique on the system.

2. Enter the DTC's LAN address in the \DTC LAN station address" �eld.

The DTC address can be found on a label on the back panel of the
DTC16iX box.

3. Type in the DTC's node name in the DTC node name �eld.

Use the format nodename.domain.organization, where nodename identi�es
the DTC. If there is more than one DTC on the system, the nodename of
each DTC must be unique.
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Note DTC name and DTC node name are two di�erent �elds.
However, it is common to use the nodename part of the DTC
node name as the DTC name, for example:

DTC name = ALPHA

DTC node name = ALPHA.ACCTG.TEKLAB

4. (Optional) Enter an IP (internet protocol) address for the DTC, if you want
this DTC to be able to respond to PING/iX requests. Otherwise, leave the
DTC IP Address �eld blank.

5. Enable the event logging classes that you want. It is recommended that you
enable classes 2 and 3 and disable classes 4 through 6.

6. Press Save Data function key (�f6�).

7. To con�gure the ports, press \Con�g Ports" function key (�f4�) to get the
following screen.
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DTC16iX Port Configuration

To con�gure the DTC16iX:

1. Verify that the DTC name is correct.

2. (Optional) Enter the port group type. The valid types are D for direct
connect and M for modem connect.

3. Press �Tab� key to move the cursor to the �rst port connector.

LDEV number used for each port connector must be unique.

4. Enter the pro�le name for each port connector in the Profile Name �eld.

For direct terminals ports, the suggested pro�le to use is TR10D96. For
direct printer ports, the suggested pro�le to use is PR18D96. For a UPS
connected to a DTC port, the suggested pro�le is UP10D12.

5. Press the Save Data function key (�F6�).

6. Press the Validate Link/DTS function key (�F6�) to validate the information
you have just supplied. The DTS validation procedure starts by displaying
the following on the terminal.
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Validation of DTS/LINK started.

NOTE: In order for any TIO changes to take effect, you must reboot the system.

Validation of DTS/LINK finished.

If the con�guration �le encounters errors, the validation procedure prints
out the total number of errors that it �nds. Error messages are also
displayed, explaining the problems found. If this occurs, correct the errors,
press Save Data again and repeat the Validate Link/DTS process.

7. After validation of the network con�guration �le is complete, a series of
SYSGEN messages will begin to appear ending with the following:

.

.

.

Cross validation with SYSGEN complete.

Copying validation configuration file to backup file, please wait ***

(Press RETURN when done viewing screen contents.)
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Note The message Cross validation with SYSGEN complete
does NOT mean that there were no con�guration conicts.
There is a con�guration mismatch if you see error or warning
messages indicating that a conict exists between the network
con�guration �le and the system I/O devices con�gured
through SYSGEN. If you see these messages, you must �rst
correct the conicts before validating again.

8. After successful validation and cross-validation, exit NMMGR by pressing the
�Prior Screen� function key until you exit out, or type EXIT at the command
line on top of any NMMGR screen and then press �Enter�.

Rebooting the system and the DTC

It is necessary to reboot your system for it to recognize the station address
that you have provided. This procedure is needed to bring new equipment into
the system's con�guration �le. Enter the following commands to reboot the
system.

1. Shut down the system by pressing the �Ctrl� and �A� keys simultaneously and
then typing the following command at the prompt (=):

= SHUTDOWN �Return�:

Note that the shutdown process could take more than 10 minutes depending
on what processes were running at the time.

Several shutdown messages ash on the screen during this shutdown process.
Some messages contain the phrase SHUT nn. The numbers at the end of the
phrase do not appear in sequence and might vary with each shutdown.

2. Wait until you see the phrase SHUT6.

3. Reset the system by pressing the �Ctrl� and �B� keys simultaneously and then
typing the following command at the prompt (CM>):

CM> RS �Return�

4. When the startup Main Menu appears, respond as follows:

Main Menu: Enter command or menu > BO �Return�
Interact with IPL (Y or N)?> y �Return�
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5. At the ISL> prompt type the following:

ISL> START NORECOVERY �Return�

6. At the system prompt, type SHOWME to make sure that you are logged on to
MANAGER.SYS. Then type the following:

:SPOOLER LP;START

:STREAMS 10

:OUTFENCE 7

7. To reset the DTC, turn o� the power and then turn on the power again for
the DTC.

Note You should reboot the DTC after rebooting your HP 3000
system.

Customizing Your Terminal and Printer Configuration

terminal con�gurationj printer con�gurationj

Your system came with a preset (also known as default) terminal and printer
con�guration. The defaults are

eight direct-connect terminal ports (ports 0-7), on the slot labeled \Slot #0 -
Direct Connect"

�ve modem-connect terminal ports (ports 0-4), on the slot labeled \Slot #1 -
Modem Connect"

one modem-connect printer port (port 5), on the slot labeled \Slot #1 -
Modem Connect"

It is possible that the default con�guration that you received with your system
is not what you need to match your o�ce setup. For instance, you may want to
use the printer port for another terminal or you may want to use the terminal
ports for more printers. This section tells you how to change the default
con�guration to match the needs of your environment.
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If you have a personal computer (PC) running in terminal emulation mode and
have it connected to the DTC, it is treated as a terminal by the DTC and the
system.

To change a terminal or printer port

To change the current terminal or printer con�guration on your system, use the
Node Management Services Con�guration Manager program, known as NMMGR.

Before you run NMMGR, you must change the hardware device (terminal or
printer) that is connected to the particular port. For example, if you want to
change a terminal port to a printer port, disconnect the terminal cable and
connect the printer cable to the DTC before you run NMMGR to con�gure the
software.

You can change a terminal port to a printer port or a printer port to a
terminal port using the NMMGR program.

If you are changing a terminal port to a printer port, it is important to know
what kind of printer you have. The following printers do status checking and
can be speci�ed as a \status printer" (S) when you are running NMMGR:

LaserJet II

HP 256X

All other printers should be speci�ed as a \printer" (P) when you are running
NMMGR.

Check the documentation that came with your printer to see if the printer is
capable of status checking. If the printer is capable of status checking, specify
S; otherwise specify P when you run NMMGR.

The default setting for terminals and printers is 9600 baud. If you want to
connect a printer at a di�erent baud rate, you must use \Advanced Con�g"
functions in NMMGR. Follow these steps to change your con�guration.

1. You must be in the MANAGER.SYS account and at the system prompt (:).
At the system prompt (:), type:

: HELLO MANAGER.SYS �Return�
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2. If you have followed the procedures in chapter 4, \Getting Your System
Ready For Use," but have not yet performed the �rst reboot of your
system, type the following commands to start NMMGR:

: RESET NMMGRCMD �Return�
: NMMGR �Return�

If you have followed the manual procedures in chapter 10, \Performing
Manual Tasks to Get Your System Ready For Use," you just need to type
the following command to start NMMGR:

: NMMGR �Return�

The terminal displays the Open Configuration/Directory File screen.
You do not need to enter any information on this screen.

3. Press the �F3� function key to move to the Quick Configuration screen.

At the top of this screen, you see the title Quick Configuration

Confirmation. This screen asks whether you are sure that you want to
enter Quick Configuration. Since you want to do this, continue to step 4.

4. Press �F1� to continue to the Quick DTC Configuration screen. This screen
allows you to change the con�guration. Notice that the cursor is positioned
in the �eld labeled DTC number.
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Figure 4-1. Quick DTC Configuration Screen

5. Type the number of the DTC whose con�guration you want to change (for
example, the DTC number would be 1, 2, or 3, depending on how many
DTCs you have) in the DTC number �eld.

6. Press �F1� (the Get DTC Info softkey) to tell the computer to display the
current con�guration of the DTC that you speci�ed. The con�guration
information is then displayed on the screen.

7. Press �Tab� to move the cursor to the �elds that specify the ports as
terminals or printers.

The numbers across the top of the �elds represent the port numbers on the
DTC:

Numbers 0 through 7 are valid for the eight direct-connect ports.
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Numbers 0 through 5 are valid for the six modem-connect ports.

The numbers going down the left side of the �elds represent the number
of slots for boards in the DTC. With this DTC, you only need to be
concerned with slot 0 or slot 1.

You can only change values in existing �elds. It is not possible to enter
values in an empty �eld.

8. Press �Tab� to move to the particular port that you want to change and
then type either a T, P, or S in the �eld, depending on whether you want
the port con�gured as a terminal (T), a printer without status checking
(P), or a printer with status checking (S). It is important that you make
sure that the port you are changing on this screen matches the hardware
connection that you changed on the DTC.

Make sure that the DTC number and DTC station address displayed on
this screen match the DTC number that you recorded earlier during the
installation process and the DTC station address on the DTC where you
made the hardware changes.

If you make an error and want to exit NMMGR, press �F8� (the Exit
softkey) so that you can return to the system prompt.

9. Press �F6� (the Save Data softkey) to save this change. Look for the
veri�cation message found under the title line at the top of the screen to
tell you when the saving process is complete.

10. Press �F2� (the Validate Config softkey) to instruct the computer
to validate the information that you have just supplied. Look for the
veri�cation message found under the title line at the top of the screen
to tell you when the validation process is completed successfully. If the
validation process was not completed successfully, do the following:

Check to make sure that you typed the information correctly.

Retype the information, if it was typed incorrectly.

Save the data again.

Validate the data.

11. Press �F8� (the Exit softkey) to leave NMMGR and return to the logon
prompt.
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To perform a final validation of your new configuration

To ensure that there are no conicts between the information that you have
supplied in NMMGR and the information found in the system con�guration �le,
you must cross-validate your con�guration. You will use the SYSGEN utility to
perform this cross-validation.

1. At the system prompt (:), type the following commands to get into SYSGEN.
Once you are in SYSGEN, you can perform the cross-validation.

: SYSGEN �Return�

The computer responds by displaying the SYSGEN prompt:

sysgen>

2. Type the following to perform the cross-validation:

sysgen> io �Return�

io> HOLD �Return�

io> EXIT �Return�

sysgen> KEEP CONFIG �Return�

Keeping to GROUP CONFIG.SYS

Purge old configuration (yes/no)? YES �Return�

Keep configuration anyway (yes/no)? YES �Return�

3. To return to the system prompt (:), when the sysgen> prompt reappears,
type:

sysgen> EXIT �Return�

4-24 Getting Your System Ready for Use



You have now completed the cross-validation process, and your con�guration
should now be operational.

4. Reboot your system by entering the following at the prompt:

: �Ctrl� �A�
= SHUTDOWN �Return�
�Ctrl� �B�
CM>RS �Return�

5. Respond Y once again to the primary boot questions, as you did in chapter
3, \Starting the Computer System." Then, once the system reboots, you
will see the ISL> prompt. At the prompt, type the following command:

ISL> START NORECOVERY �Return�

This step ensures that the new con�guration that you created is used by the
system instead of the default con�guration. When you reboot the system
and power cycle the DTC, the terminals and printers should be ready for
the next step.

6. At the system prompt (:), type the following:

: HELLO MANAGER.SYS;HIPRI �Return�

Enter any passwords, if necessary.

7. Turn the DTC(s) o�, then back on again (known as power cycling) by
pressing the DTC power switch, located in the lower left corner of the front
panel. If your DTC is currently o�, all you need to do is turn it on.

When the console has displayed a message stating that the DTC has
downloaded successfully and the green light on the DTC front panel has
stopped ashing, you are ready to use your system.

If the green light on the DTC front panel continues ashing after �ve
minutes, check the cabling and the DTC station address entered in NMMGR.
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Booting the System

At times you may need to boot the system; for example, if you change the
system's con�guration or need to recover the operating system and software,
you might need to boot your system.

Note Keep in mind that these tasks should be performed only by
system management trained personnel or a Hewlett-Packard
Service Representative as these procedures may result in loss of
user data if performed inappropriately.

Examples given are representative of booting up from the disk drive (Primary
Boot Path) and booting up from a tape (Alternate Boot Path).

After you power on the system, a screen similar to the following appears on the
console screen:

d a

c b

---------------------------------------------------------------------

PDC - Processor Dependent Code - Version x.x

(c) Copyright 1990-1993, Hewlett-Packard Company, All rights reserved

----------------------------------------------------------------------

0 Bytes of memory configured an tested.

Primary boot path: 0/0/0/0/0/0/0.0.0.0.0.0.0 (dec)

Alternate boot path: 0/0/0/0/0/0/0.0.0.0.0.0.0 (dec)

Figure 4-2. Initial Menu
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This screen is followed by the Main Menu.

d a

c b

--Main Menu-----------------------------------------------------

Command Description

------- -----------

BOot [PRI|ALT|<path>] Boot from specified path

PAth [PRI|ALT|CON][<path>] Display or modify a path

SEArch [DIsplay|IPL] [<path>] Search for boot devices

COnfiguration menu Displays or sets boot values

INformation menu Displays hardware information

SERvice menu Displays service commands

DIsplay Redisplay the current menu

HElp [<menu>|<command>] Display help for a menu or command

RESET Restart the system

----

Main Menu: Enter command or menu >

Figure 4-3. Main Menu
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Booting from the Primary Path

If you need to boot from the disk, enter the following at the Main Menu
prompt:

Main Menu: Enter command or menu > BO �Return�
Interact with IPL (Y or N)?> y �Return�

Note Booting from the primary path is the system default, therefore
when BO is typed at the prompt, BO PRI is assumed.

The system responds with a screen similar to the following:

Booting...

Boot IO Dependent Code (IODC) revision 4

.

.

.

ISL>

Booting from the Alternate Path

If you need to boot from tape, do the following at the Main Menu prompt:

Main Menu: Enter command or menu > BO ALT �Return�
Interact with IPL (Y or N)?> y �Return�

The system responds with a screen similar to the following:

Booting...

Boot IO Dependent Code (IODC) revision 4

.

.

.

ISL>
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5

Using and Maintaining the Tape Drive

This chapter describes procedures for the tape drive that comes with your HP
3000 Series 9X8LX. A DDS tape drive stores data on cassette tapes in a format
called digital data storage (DDS). To avoid loss of data and damage to your
DDS drive, use only properly certi�ed DDS cassette tapes, not DAT tapes,
which are only tested for audio use. Hewlett-Packard makes no warranty for
tapes other than those sold speci�cally for this tape drive and recommends
that you use Hewlett-Packard DDS cassettes with your DDS-format drive.

The digital data storage (DDS) tape drive is mounted in the same cabinet with
the computer. The tape drive is located just below the computer switches and
indicators. The tape drive that comes with your computer system is the one
shown in Figure 5-1.

Figure 5-1. HP C1503A 3.5-Inch Tape Drive Front Panel
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Getting To Know Your Tape Drive

When familiarizing yourself with the tape drive and its indicators, here are
some terms for you to know.

Cassette Slot: is where the tape cassette is inserted and removed.

Unload Button: stops any tape operation, rewinds the tape, and ejects the
cassette from the tape drive.

Cassette Light and Drive Light: indicate the status of the tape drive. Both
lights are capable of displaying yellow or green colors. The combinations
of green lights, yellow lights, and no lights, show normal operation status,
operation with write protect, and caution states.

Ordering HP DDS Cassettes

The 60-meter cassette tape, product number HP 92283A, can hold up to 1.3
gigabytes (1300 megabytes) of data. These cassettes are packaged in red boxes,
�ve cassettes to a box.

The 90-meter cassette tape, product number HP 92283B, can hold up to 2
gigabytes (2000 megabytes) of data. These cassettes are packaged in a yellow
box.

The cleaning cassette tape is product number HP 92283K .

Table 5-1 shows the types of DDS tapes available and which tape drives they
are compatible with. This is important to know before loading a DDS cassette
into a tape drive for operation.
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Table 5-1. DDS Tape Requirements

HP 3.5-inch
C1503A

Non-HP
DDS Device

60M (red) Read (yes)
Write (yes)

Read (yes)
Write (yes)

90M (yellow) Read (yes)
Write (yes)

Read (*)
Write (*)

*Refer to the manufacturer's speci�cation.

Operating a DDS Tape Drive Using DDS Cassettes

Operating your tape drive consists of knowing how to do the following:

preparing your cassette

loading and unloading your cassette

making a tape for read only

making a tape for read and write

handling and storing your cassette

periodic tape head cleaning
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Preparing Your Cassette

When preparing your cassette for loading into the tape drive, you must decide
if the cassette should be a read-and-write tape or a read-only tape.

To allow a cassette to be written on

To allow a cassette to be written to as well as read from, slide the tab on the
rear edge of the cassette so that the recognition hole is closed. This cassette is
a read-and-write tape as shown in the following illustration.

Figure 5-2. Close the Recognition Hole to Write on a Cassette

To protect data on a cassette

To protect the data on a cassette from being altered or overwritten, you can
make a read-only cassette. To do this, slide the tab on the rear edge of the
cassette so that the recognition hole is open.
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To load a cassette

To load your cassette into a digital data storage (DDS) tape drive:

1. Insert the tape cassette squarely into the slot in the front of the drive. Make
sure that the label is facing uppermost, then follow the arrowhead on the
cassette case. Only minimum force is necessary when doing this. Do not
restrain the cassette when pushing it into the drive because it could jam
in the mechanism. The drive automatically ejects an incorrectly loaded
cassette after 10 seconds.

Figure 5-3. Inserting a Cassette

2. Locate the cassette squarely in the slot (not at an angle). Using single-�nger
pressure on the rear of the cassette allows the autoloading mechanism to
take the cassette and load it into the drive. The loading sequence to thread
the tape takes about 25 seconds.

3. Observe that the load sequence is �nished when only the cassette light
remains lighted. The light is a steady green if the cassette is read and write,
and is yellow if the cassette is read only.
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Caution Do not try to load another cassette when a cassette is already
in the drive. Check for a \cassette loaded" indication on your
tape drive if you are not sure whether or not a cassette is
loaded.

To unload a cassette

To unload your cassette from the tape drive:

1. Press the unload button on the front panel.

Figure 5-4. Unloading a Cassette

This starts a sequence that rewinds the tape to the beginning and ejects the
cassette. The sequence takes about 10 seconds.

During the unload sequence, both front panel lights pulse green (yellow if
the tape is read only).

2. Remove the cassette, label it appropriately, and store it in its plastic case.
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To label a cassette

In order for you to identify what kind of information is stored on the cassette,
it is important for you to have a label on it. When you label your cassette,
follow these guidelines:

Use only one label on each cassette.

Use only standard labels recommended for cassettes.

Stick the label only in the label area. Do not stick anything else to the
cassette.

Interpreting Indicator Status Lights

The various status states that you will see displayed are shown in the following
table.

The cassette indicator and the drive indicator are bi-color light emitting diodes
(LEDs). They can show green or yellow light.
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Table 5-2. HP 3.5-inch DDS Tape Drive

Cassette Light Drive Light Condition

No Cassette States

O� O� No cassette loaded, or power is o�.

Flash Yellow Flash Yellow Self-test in progress.

On Green Flash Green No cassette; tape drive is active.

Write Enable States

On Green On Green Cassette loaded; tape drive online.

On Green Flash Green Cassette loaded; tape drive active.

Pulse Green Pulse Green Loading, unloading, or ejecting cassette.

On Green O� Tape drive o�ine.

Write Protect States

On Yellow On Green Read-only cassette loaded; tape drive online.

On Yellow Flash Green Read-only cassette loaded; tape drive active.

Pulse Yellow Pulse Green Loading, unloading, or ejecting cassette.

On Yellow O� Tape drive o�ine.

Error States

On Green Pulse Green/Yellow Caution1 (media warning).

On Yellow On Yellow Moisture detected,2 or no termination resistors.

Pulse Yellow On Yellow Fault3.

1 This occurs during writes where an excessive number of read-after-write
errors occur and during reads where an excessive level of C3 correction is being
applied. This indication would persist until the cassette is unloaded.

2 The termination resistor problem occur only at power-on time, and the tape
drive appears to have hung during self-test.

3 Indicates a failure of the DDS �eld replaceable unit.
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Interpreting Status Signal Conditions

When operating your tape drive, be aware of the indicator lights displaying
conditions to notify you of the status.

If you have a read-only tape

If the cassette is a read-only tape, the cassette light shows yellow during
normal operations.

If you see a caution signal

The caution signal is indicated by the cassette light alternating between green
(for 4.5 seconds) and o� (for 0.5 seconds). For normal operation, it typically is
a steady green. If this caution condition occurs, it means that the tape drive is
having to correct an excessive number of errors when using the cassette. This
can mean that the tape heads need cleaning or that the tape is nearing the end
of its useful life.

When you see a caution signal, �rst clean the tape heads using the tape
cleaning procedures described later in this section. If the signal occurs again,
you should copy the data from the tape onto a new tape using this procedure
sequence:

1. Copy the data from the tape onto disk.

2. Copy the data from the disk onto a new tape.

3. Discard the old tape.

If the humidity is high

If the humidity rises too high, both front panel indicators show a steady yellow.
The tape drive will not perform any operations requiring movements of the
tape until the humidity has dropped to within speci�cation again. Refer to
\Handling and Storing Cassettes" in this chapter for information on how to
handle your cassette tapes in these conditions.
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If you have a fault warning

If a fault is diagnosed during the self-test performed when the system is
switched on, the result is indicated by the cassette light pulsing in groups of
one, two, or three pulses, while the drive light shows a steady yellow. If this
happens, make a note of the pattern and, call your Hewlett-Packard support
representative.

If You Need to Copy Data From the Tape Onto Disk

Caution The following procedure can cause good data �les to be written
over by corrupted �les. Before proceeding on to the following
task, be sure that you fully understand the scope of the
commands being used.

Use the RESTORE command and its options to copy �les from your cassette tape
back onto the system. Before you restore the �les, use the RESTORE command
with the LISTDIR option to display the �les on the tape. After determining
the �les to be restored, issue the RESTORE command with the SHOW option.

To restore your �les, follow these steps. (If you are already in MANAGER.SYS,
omit step 1.)

1. Use the HELLO command to log on as MANAGER.SYS.

: HELLO MANAGER.SYS �Return�

2. Load the cassette tape into the tape drive from which you wish to copy �les
to the system disk.

3. For the HP 3000 Series 9X8LX with the built-in tape drive, type this �le
equation at the system prompt (specifying @.@.@ will restore all the �les to
the system disk):

: FILE T;DEV=TAPE �Return�
: RESTORE *T;@.@.@;SHOW �Return�
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For additional information about restoring �les, refer to the book, Task
Reference (B3813-90009).

If you need to copy from the system disk onto a new tape

Use the STORE command and its options to copy your �les from the system
disk onto a cassette tape. Begin by using the FILE command to create a �le
equation to specify the tape device that you wish to copy to. For the HP 3000
9X8LX with the built in tape drive, use the FILE T;DEV=TAPE �le equation. In
the command line for STORE, use the SHOW option to list the �les to verify that
they are the �les that you wanted to copy onto tape.

You should still be in the MANAGER.SYS account when you are copying from the
system onto the cassette tape. Begin by loading your read-and-write tape into
the tape drive, and then proceed with one of these procedures:

To copy more than one �le to tape, type the following at the system prompt:

: FILE TAPE1;DEV=TAPE �Return�
: STORE filename, filename, filename;*TAPE1;SHOW �Return�

To copy all �les in a group to tape, type the following at the system prompt:

: FILE TAPE1;DEV=TAPE �Return�
: STORE @.groupname;*TAPE1;SHOW �Return�

Handling and Storing Cassettes

Environmental conditions can a�ect the reliability of data stored on cassette
tapes. It is recommended that you only use cassettes labeled \DDS" in your
DDS-format tape drive. Do not use cassettes labeled \DAT," because the
media is not certi�ed and integrity cannot be guaranteed. It is recommended
that you only use DDS cassettes marketed by Hewlett-Packard, which meet
exacting high standards.

To ensure data integrity for your cassettes, follow these guidelines:
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Do not touch the tape or attempt to clean the tape path or tape guides
inside the cassette.

Do not leave cassette tapes in excessively dry or humid conditions.

Do not leave cassette tapes in direct sunlight or in places where magnetic
�elds are present (for example, under telephones or near transformers).

Do not drop cassettes or handle them roughly.

Do not stick more than one label onto cassettes; extra labels could cause the
cassettes to jam in the tape drive.

Store cassettes in their plastic cases when not in use.

Do not let cassettes get dirty, and always stack the cassettes in a clean
environment.

Do not use cassettes when the Caution signal is displayed by the cassette
light, located on the front panel. The light shows a repeating pattern of
green for 4.5 seconds, then o� for 0.5 seconds. If this light pattern appears, it
means that the tape heads need cleaning or that the tape is nearing the end
of its useful life.

Temperature considerations

The cassettes should be used only at temperatures between 5�C (41�F) and
45�C (113�F). You can, however, store them at temperatures down to -40�C
(-40�F).

If you expose cassettes to temperatures outside the operating limits, stabilize
them before you use them. To do this, leave the cassettes in the recommended
operating temperature for a minimum of two hours.

To avoid temperature problems, observe these guidelines:

Ensure that the tape drive is in a position where the temperature is
relatively stable, for example, away from open windows, fan heaters, and
doors.

Avoid leaving cassettes in severe temperature conditions, for example, in a
car standing in bright sunlight.

Avoid transferring data (reading from and writing to cassettes) when the
temperature is changing by more than 10�C (50�F) per hour.
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Environmental and usage limits

Appropriate conditions of operating, storage (long-term), and transporting
environments for your cassette tapes are as follows:

Operating temperature is 5�C to 45�C (41�F to 113�F).

Operating humidity is 20% to 80% relative humidity, non-condensing.
Maximum wet bulb temperature is 26�C (79�F).

Storage temperature is 5�C to 32�C (41�F to 90�F).

Storage humidity is 20% to 60% relative humidity, non-condensing.
Maximum wet bulb temperature is 26�C (79�F).

Transporting temperature is -40�C to 45�C (-40�F to 113�F).

Transporting humidity is 5% to 80% relative humidity, non-condensing.
Maximum wet bulb temperature is 26�C (79�F).

Recommended useful life of a cassette is 300 insertions into the tape drive.

To determine storage life of a DDS cassette

Data can successfully be stored on DDS cassettes for a period of 10 years.
You should give each cassette a full pass in the drive at least once a year to
prevent sticking. Store cassettes according to the environmental speci�cations
mentioned.

Cleaning Tape Heads and Choosing Your Cassettes

The environment in which you use your tape drive and store the cassettes
helps provide optimum conditions for good performance. It is also important
that you take care to ensure that reliability continues. You can do this through
regular cleaning of the tape heads in the drive and through correct handling of
the cassettes. Cleaning the tape heads helps prevent problems of data integrity
in two areas:

head clogs, when a speck of dirt adheres to the tape head and prevents data
from being read or written correctly
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scratches on the tape, usually caused by dirt particles becoming trapped
between a tape guide and the tape and scratching the surface as the tape
passes by

Any of the following conditions indicate that the tape heads need cleaning:

after every 25 hours of use

if the tape drive indicates that it is correcting an excessive number of errors
(See your tape drive manual for details.)

when the green Caution signal displayed by the cassette light, located on the
front panel, is active

when both the cassette and drive lights are on yellow

To clean the tape heads

Use the following procedure to clean the tape head:

1. Insert the cleaning cassette, product number HP 92283K, into the tape drive
slot. (Do not use swabs or other means of cleaning the heads.) The tape
drive automatically loads the tape and cleans the heads. When the cleaning
is complete, the tape drive unloads and ejects the tape.

2. After each cleaning, record on paper that the cleaning cassette has been
used.

3. Discard the cleaning cassette after 25 uses. Ensure that you have another
cleaning cassette to use.

To choose cassettes labeled DDS

It is important that you use cassettes labeled \DDS" in your DDS-format
drive. Do not use cassettes labeled \DAT," because the media is not certi�ed
and, therefore, integrity cannot be guaranteed. In addition, DAT cassettes
have a di�erent mechanical speci�cation, which may cause them to jam in the
mechanism. Damage caused by the use of non-DDS media may invalidate the
warranty on your tape drive.
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To determine number of DDS cassettes needed

The total number of cassettes needed depends on your backup routine;
however, it is advisable to keep extra cassettes for the following:

a spare set for full backup

a spare cassette for use for diagnostics by your Hewlett-Packard customer
engineer

cassettes for �le transfers

cassettes for any archival storage you may require
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6

Getting Started with HP Easytime/iX

This chapter describes how to log on to your system and start
HP Easytime/iX, and how to exit HP Easytime/iX and log o�. It also
explains and lets you practice the basic skills that you need to use the product
e�ectively, including the following:

logging on and starting HP Easytime/iX

exiting HP Easytime/iX and logging o�

getting help

using the Main menu

working with screens

working with menus

working with list boxes

working with dialog boxes

understanding operating modes

practicing basic skills
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Are You Ready?

Every HP 3000 Series 9X8LX arrives with HP Easytime/iX preinstalled. If you
did not receive HP Easytime/iX installed as part of your system, you need to
install the software before you can use the program. You receive the program
on either a 1/2-inch magnetic tape or on a digital data storage (DDS) cassette.

To install HP Easytime/iX

MPE/iX system manager or operator capabilities are required to install
HP Easytime/iX. Follow the installation instructions that you received with
your tape.

To customize HP Easytime/iX

If you are the system manager, you can use the setup program to customize the
HP Easytime/iX program. See \Customizing HP Easytime/iX" in chapter 3 of
this manual. This program is optional. HP Easytime/iX arrives set up for you.
You can use it as is, or customize it to meet your particular needs.

To enable HP Easytime/iX

Before you can use HP Easytime/iX, the program must be enabled. This is a
system administrator responsibility. If you are not the system administrator,
ask the system administrator to do this for you.

1. Log on to the system as MANAGER.SYS.

2. From the system prompt, type:

:RUN EASYTIME.PUB.SYS �Return�

3. Press �F5�
NNNNNNNN
OK to enable HP Easytime/iX.

You can now start HP Easytime/iX and begin performing tasks. If, at some
later time, you need to disable HP Easytime/iX again, see the following
procedure.
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To disable HP Easytime/iX

Disabling HP Easytime/iX is a system administrator responsibility. You may
want to do this, for example, before a system shutdown.

1. Log on to the system as MANAGER.SYS.

2. Start HP Easytime/iX.

3. Switch to system administrator mode.

4. From the Main menu, press �D� for Disable HP Easytime/iX.

A dialog box prompts you for con�rmation.

5. Press �F5�
NNNNNNNN
OK to con�rm disabling HP Easytime/iX.

6. Press �F5�
NNNNNNNNNNN
Yes to con�rm again.
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Logging On and Starting HP Easytime/iX

Logging on means identifying yourself to the computer. You must identify
yourself as an authorized user by typing your logon identity (user name and
account) and a password (if any). If you do not have a logon identity, ask your
system administrator to give you one.

Once you log on, you begin your communication with the HP 3000 computer
and can start working.

To log on

1. After switching on the terminal, press �Return� one or more times until you
see the system prompt.

2. Type your logon identity. For example:

MPE XL:HELLO PAT.FINANCE

3. Press �Return�.

4. Type any required passwords.

As a security precaution, passwords are not displayed on the screen as you
type them.

5. Press �Return�.

A system prompt (:) signals the start of your session. A welcome message
may also be displayed.
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To start HP Easytime/iX

Once you have logged on (and the program is enabled), you can start HP
Easytime/iX.

1. From the system prompt, type:

:RUN EASYTIME.PUB.SYS �Return�

Unless your system administrator has changed this, the Main menu is
displayed on your screen. This is where you begin your work. The �gure
below illustrates the Main menu.

Figure 6-1. Main Menu

Welcome to HP Easytime/iX! Now you are ready to begin learning about basic
skills and HP Easytime/iX tasks.
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The following pages describe the basic skills that you need to use HP
Easytime/iX. If you do not want to continue with basic skills now, you can exit
HP Easytime/iX with the following procedure.

To exit HP Easytime/iX

1. Press �F2� �E� to open the Exit menu.

2. Press �X� for Exit HP Easytime/iX.

3. Press �F5�
NNNNNNNNNNN
Yes to con�rm that you want to exit.

This ends your current HP Easytime/iX session.

To go to the MPE/iX operating system

You can also exit HP Easytime/iX temporarily to execute an MPE/iX
command or start another application, and then quickly return to
HP Easytime/iX.

1. Press �F8�
NNNNNNNNNNNNNNNNN
Close one or more times until the Main menu appears.

2. Press �G� for Go to MPE.

The MPE/iX system prompt is displayed on your screen. You can now enter
an MPE/iX command or start another application.

3. Type EXIT when you want to return to HP Easytime/iX.

If you do not need to return to HP Easytime/iX, you can type BYE to end
your MPE/iX session and log o�. When you end your MPE/iX session, you
end your HP Easytime/iX session as well.

To log off

1. Exit HP Easytime/iX.

2. From the system prompt, type BYE.

A closing message displays the current time, date, and amount of CPU time
that your session used. Switch o� the terminal screen after you receive the
disconnect message.
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Getting Help

There are two ways to get help in HP Easytime/iX. You can access the Help

menu for a complete index of help topics, or you can press �F1�
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Field Help for

context-sensitive help about an object on the screen.

The HP Easytime/iX Help menu is available on every screen. The Help menu
provides the following six categories of help information:

Use this topic To do this

Help Access information about the HP Easytime/iX
help facility.

Basic skills Access information about basic skills and
concepts that you will need to use the product
e�ectively.

Procedures Access step-by-step procedures for every task
available on a screen.

Keys Access information about cursor movement
keys, dialog box keys, function keys, and editing
keys in HP Easytime/iX.

Glossary Access an alphabetical listing of
HP Easytime/iX terms and de�nitions.

Version Access information about the current version of
HP Easytime/iX on your system.

To use the Help menu

1. Press �F4� �H� to open the Help menu.

2. Press the key that corresponds to the underlined character in the menu item
that you want. For example, press

�P� for help on Procedures.

An index of help topics for this screen is displayed.
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Figure 6-2. Index of Help Procedures

To select and read a help topic

1. Press ��� or �	� to move the cursor to a help topic.

2. Press either �F3�, �Spacebar�, or �Return� to select the topic.

3. Press �F5�
NNNNNNNNNNNNNN
Read .

A help window displays help information about that topic.

4. Press �F8�
NNNNNNNNNNNNNNNNN
Close when you are �nished reading.

If you want to choose another help topic, press �Tab� twice to go back to the
list of topics and select another.

5. Press �F8�
NNNNNNNNNNNNNNNNN
Close again to close the Help menu.
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To use the help key

With the help key you can access �eld-speci�c help about an object on the
screen or in a menu, for example, a task or a data-entry �eld.

1. Move the cursor to an object on the screen.

2. Press �F1�
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Field Help to get help information about that object.

3. Press �F8�
NNNNNNNNNNNNNNNNN
Close to close the help window when you are �nished reading.
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Using the Main Menu

The Main menu is your focal point in HP Easytime/iX and usually the �rst
thing that you see after starting HP Easytime/iX. Through the Main menu,
you can access any HP Easytime/iX screen.

To open a screen from the Main menu

1. Press the key that corresponds to the underlined letter in the screen that
you want to open, for example, press

�P� for Print File Management

Or, use the ��� or �	� keys to highlight the screen that you want, and press
�Return�.

To get help about Main menu items

1. Press ��� or �	� to highlight a menu item.

2. Press �F1�
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Field Help to get context-sensitive help about that screen or

task.
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Working with Screens

Each area of management in HP Easytime/iX (for example, File or Session
Management) is displayed on a screen. Through screens you can access
information about the current status of the system and perform system
management tasks.

To identify the parts of a screen

Each HP Easytime/iX screen contains the following:

title bar A horizontal bar that is located at the top of each screen and
contains the name of the screen.

menu bar A horizontal bar located directly below the title bar containing
the names of the HP Easytime/iX menus.

status line The third line on your screen (directly below the menu bar).
The status line displays messages from the system that tell you
when you need to do something, for example, load a form in
the printer. The status line also displays the time the screen
was last updated.
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list box A box listing available choices, for example, a list of available
�les on the system.

message line The bottom line on your screen. Information about what is
happening on the system is displayed here.

function keys Along the top of the keyboard are eight keys labeled F1
through F8. These function keys correspond to the eight
function key labels along the bottom of each HP Easytime/iX
screen.
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Working with Menus

All HP Easytime/iX menus appear on the menu bar. The menu bar appears
directly below the title bar. Each menu contains a list of available tasks (menu
items) that let you determine what action to take next. You can also access the
Main menu from the menu bar on any HP Easytime/iX screen.

To open a menu

You can open any menu in HP Easytime/iX by going to the menu bar and
pressing the key that corresponds to the underlined letter in the menu that you
want to open. For example, to open the Actions menu:

1. Press �F4� to go to the menu bar.

2. Press �A� to open the Actions menu.

You can also use �F2�
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Fast Select and an underlined character for a faster

method of opening menus. For example, press �F2� �A� to open the Actions
menu.
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To choose a menu item

All HP Easytime/iX tasks are listed on menus. You perform tasks by choosing
the menu item.

1. Press the key that corresponds to the underlined character in the menu item
that you want. For example, press

�D� for Delete.

Or, use ��� or �	� to highlight the menu item that you want, and press
�Return�.

To close a menu

Press �F4� again to close a menu and exit the menu bar.

Or, press ��� or ��� to open other menus on the menu bar.

You automatically close one menu when you open another.
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To understand menu conventions

Not all HP Easytime/iX menu items look the same. Menu items can be
shaded, preceded by an asterisk, highlighted, or followed by an ellipsis ( . . . ).
Additionally, each menu item has one letter underlined. The following table
explains HP Easytime/iX menu conventions.

Menu convention De�nition

Shaded This menu item or screen is not available. This
can be because you are currently working on
this screen, or because system administrator
access is required to perform the task.

Ellipsis ( . . . ) Indicates that a dialog box or another screen
will appear when you select this item.

Asterisk Indicates which default setting is active.

Underlined Character Indicates which key to press to access a menu
or to select a menu item.

Working with Menus 6-15



Working with List Boxes

Each HP Easytime/iX screen contains at least one list box . A list box is
an area displaying columns of information. These can be items related to
the current HP Easytime/iX screen, for example, a list of �les on the File
Management screen, or a list of available choices, for example, printers
currently available on the system.

To identify a list box

Every list box contains a scroll bar on the right edge (and/or bottom edge) of
the list box. If there are more items available than �t in the list box, scroll
bars allow you to scroll through the list to view more information. The scroll
bar arrows indicate the directions that you can scroll in a list.

Figure 2-6 illustrates the list box on the File Management screen.
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To scroll in a list box

The cursor keys that you use depend on the kind of terminal and keyboard
that you have. You can use the following keys to scroll in a list box:

To scroll Press these keys

Up one line ���

Down one line �	�

Up one page �Scroll Up�

�Shift� + ���

Down one page �Scroll Down�

�Shift� + �	�

Right one page �Next�

Left one page �Prev�

To the top of the list ���

To the bottom of the list �Shift� + ���

To select items in a list box

When working in a list box, you can select one item, multiple items, a range of
items, or all items.

To select one or more items

1. Move the cursor to the item that you want to select.

2. Press either �F3�, �Return�, or �Spacebar�.

The item that you selected should now be highlighted.

If you selected the wrong item, you can cancel your selection by pressing
�F3�, �Return�, or �Spacebar� again.

3. Repeat steps 1 and 2 to select as many items as you like.
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To select a range of items

1. Move the cursor to the �rst item that you want to select.

2. Press �F2�
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Fast Select and then �F3�

NNNNNNNNNNNNNNNNNNNN
Select .

3. Move the cursor to the last item that you want to select.

As you move the cursor, the items in the list are highlighted line by line.

4. Press �F2�
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Fast Select and then �F3�

NNNNNNNNNNNNNNNNNNNN
Select to end the range selection.

To select all items

Press �F2�
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Fast Select and then �/�.

All items in the list are selected. This includes items that are not visible in
the list box.

To cancel all selections

Press �F2�
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Fast Select and then �n�.

Or, press �F5�
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Update Display .

Updating the display always cancels any selected items.
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Working in Dialog Boxes

HP Easytime/iX uses dialog boxes to present information or to prompt you for
data needed to complete a task. Dialog boxes are windows that appear on your
screen overlaying a portion of the current display.

Dialog boxes usually contain one or more �elds (areas that you can �ll in or
edit), or a list of choices from which you can select a value.

Whenever an ellipsis ( . . . ) appears after a menu item, you know that a dialog
box (or another screen) follows.

When a dialog box appears, you may be asked to input information in any of
the following ways:

Type the information in a �eld.

Select one or more items in a list.

Choose from a set of available options.
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To type text in a field

1. Press �Tab� to move from one data-entry �eld to the next.

2. Type the requested information.

To correct typing errors

You can use any of the following keys to correct typing errors:

To do this Press these keys

Go to insert mode �Insert char�

Exit insert mode �Insert char� again

Delete a character �Delete char�

Delete one character to the left �Backspace�

Delete all characters �Delete line�

Delete all characters to the
right of the cursor

�Clear line�

To select from a list in a dialog box

You can select only one item from a list that appears within a dialog box.
Often, one item that is highlighted (preselected) for you.

1. Use the ��� and �	� keys to move the cursor to the item that you want to
select.

2. Press either �F3�, �Return�, or �Spacebar�.
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To choose options in a dialog box

1. Press �Tab� to move to the option that you want.

2. Press either �F3�, �Return�, or �Spacebar� to choose the option.

Selected choices are marked by either an asterisk <*>, or by [X].

To move in a dialog box

< > You can use the following keys to move around in a dialog box:

To move Press these keys

To the next �eld �Tab�

To the previous �eld �Shift� + �Tab�

One character to the right ���

One character to the left ���

To close a dialog box

After you have supplied the requested information, press �F5�
NNNNNNNN
OK to complete

a task and close the dialog box.

To cancel a dialog box

Press �F8�
NNNNNNNNNNNNNNNNNNNN
Cancel to cancel a task and close the dialog box.
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Understanding Operating Modes

There are two operating modes in HP Easytime/iX:

user mode

system administrator mode

When you start HP Easytime/iX, you are automatically in user mode. In this
mode, some tasks are not available (shaded). Usually, shaded tasks require
system administrator access.

To set the system administrator password

A password is required when changing to system administrator mode. If you
are the system administrator, you set the system administrator password the
�rst time that you change to system administrator mode.

1. Log on as MANAGER.SYS.

2. Start HP Easytime/iX.

3. From the Main menu, press �A� for Switch to System Administrator.

4. Type the system administrator password, and press �Return�.

The password must begin with a letter and can contain eight alphanumeric
characters. For security reasons, each character that you type is displayed as
an asterisk (*).

5. Type the password again for veri�cation.

6. Press �F5�
NNNNNNNN
OK to set the system administrator password.

To change to system administrator mode

You must be in system administrator mode to perform every HP Easytime/iX
task and to manage all �les, jobs, and sessions on the system.

1. From the Main menu, press �A� for Switch to System Administrator.

2. Type the system administrator password.
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The password must begin with a letter and can contain eight alphanumeric
characters. For security reasons, each character that you type is displayed as
an asterisk (*).

3. Press �F5�
NNNNNNNN
OK to change to system administrator mode.

To change to user mode

If you are in user mode, you can manage only your own �les, jobs, and sessions.

From the Main menu, press �U� for Switch to User.

No passwords are required when changing to user mode.

To change the system administrator password

For security reasons, it is a good idea to change the system administrator
password on a regular basis. Be sure not to use a word that is easy to identify,
such as your own name. This is a system administrator task.

1. Change to system administrator mode.

2. From the Main menu, press �W� for Change Administrator Password.

3. Type the new password, and press �Return�.

The password must begin with a letter and can contain eight alphanumeric
characters. For security reasons, each character that you type is displayed as
an asterisk (*).

4. Type the new password again for veri�cation.

5. Press �F5�
NNNNNNNN
OK to change the password.
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Practicing Basic Skills

This section guides you through a few tasks so that you can practice using
some of the basic skills just introduced. A �le called ETLEARN has been created
for you to use throughout these exercises. Please do the tasks in the order that
they are presented, as later tasks build on previous ones.

To prepare to practice basic skills

The �le ETLEARN is located in the public group of the system account,
PUB.SYS. Programs and applications available to all users of the system reside
here. Before you can begin working with the ETLEARN �le, you need to copy it
to your own group.

If you are not already at the system prompt (:),

1. Press �F8�
NNNNNNNNNNNNNNNNN
Close one or more times until the Main menu screen is displayed.

2. Press �G� for Go to MPE.

3. At the system prompt, type:

:COPY ETLEARN.PUB.SYS �Return�

This command copies the �le ETLEARN to your logon group and account.

4. From the system prompt, type:

:EXIT �Return�

This command takes you back to HP Easytime/iX.

To read a file

You can read the contents of any �le if you created it, or if you have read
access as provided through MPE/iX security. With this task, you can read the
contents of ETLEARN.

1. From the Main menu, press �F� for File Management.

2. Select the �le ETLEARN.

3. Press �F2� �A� to open the Actions menu.
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4. Press �R� for Read.

The �rst 15 lines of the �le are displayed on your screen. You can use the
scroll keys to browse through the contents of the �le.

5. Press �Shift� + �	� to scroll to the next page.

6. When you are �nished reading, press �F8�
NNNNNNNNNNNNNNNNN
Close to close the �le and go

back to the File Management screen.

To print a file

When you request a �le to be printed, you create a print �le . A print �le is a
copy of the �le that the system creates and sends to the printer. You print �les
from the File Management screen.

1. Select the �le ETLEARN from the File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �P� for Print.

A dialog box prompts you to type the number of copies that you want
printed.

4. Type 3 in the No. of copies �eld.

5. Press �F5�
NNNNNNNN
OK .

You have requested three copies of the �le ETLEARN to be printed.
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To copy a file

You can copy �les to the same group or to another group in your logon
account. With this task, you are going to make a copy of the �le ETLEARN and
keep it in your logon group.

1. Select the �le ETLEARN from the File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �C� for Copy.

A dialog box prompts you to type a �le name and group.

4. Type a new name for the �le ETLEARN.

A �le name can be a maximum of eight alphanumeric characters and must
begin with a letter.

You want to keep the �le in your logon group, so leave the group �eld as it
is.

5. Press �F5�
NNNNNNNN
OK to copy the �le.

To delete a file

You can delete your own �les from the system. It is important to remember
that when you delete a �le, you cannot get it back, except possibly from a
backup tape.

1. Select the �le ETLEARN from the File Management screen.
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2. Press �F2� �A� to open the Actions menu.

3. Press �D� for Delete.

Whenever you delete a �le, HP Easytime/iX prompts you to con�rm the
action.

Confirmation Dialog Box

4. Press �F5�
NNNNNNNNNNN
Yes to con�rm that you want to delete this �le.
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7

Performing Tasks Using HP Easytime/iX

This chapter describes the tasks that you can perform with HP Easytime/iX.
HP Easytime/iX helps you to manage your system by organizing your daily
tasks around menus that are easy to identify and use. These tasks are
separated into the following categories:

managing sessions

managing �les

managing print �les

managing printers

managing jobs

managing backups

managing console messages

customizing HP Easytime/iX

solving problems
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Managing Sessions

When you log on to the MPE/iX system, you begin a session. This is your
means of communicating with the computer. A session begins when you log on
(HELLO) and ends when you log o� (BYE).

The menus at the top of the Session Management screen contain all of the
tasks necessary for managing your sessions, including the following:

deleting sessions

sending messages to other users

limiting the number of sessions on the system

displaying a set of sessions

sorting a list of sessions

To access Session Management

1. Move the cursor to Session Management on the Main menu.

2. Press either �F3�, �Return�, or �Spacebar�.
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The Session Management screen provides information about all the sessions
that are logged on to the computer, including:

name of the session

user name and account of the session

name of the program that the session is running (if there is one)

date and time when the session was started

which session is your session

The following �gure illustrates the Session Management screen.

Figure 7-1. Session Management
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To delete (abort) a session

Before performing routine maintenance on the system, for example, a backup,
you may want to delete any active sessions (log other users o� the system).
This ensures that any �les currently locked by an application are available for
backup.

1. Select one or more sessions from the Session Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �D� for Delete.

A dialog box prompts you to con�rm deletion.

4. Press �F5�
NNNNNNNNNNN
YES to delete sessions.

Caution If a user is working in an application, this task aborts the
program, and data may be lost . For this reason, be sure to
send a warning message prompting users to log o� before you
delete sessions. See the following procedure about how to send
messages to users.

To send messages to users

You can send messages to one or more users on the system. For example, you
can send a message asking users to log o� before you shut down the system.

1. Select one or more sessions from the Session Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �S� for Send Message.

4. Type the message to be sent to other users.

Your message can be up to 80 characters in length. The �eld shifts to the
left as you type, providing more space.

If you want a user to reply to your message, be sure to include your session
name so that the user knows which session to answer. The session name and
user are not automatically displayed with the message.
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5. Press �F5�
NNNNNNNN
OK to send the message.

To limit the number of sessions on the system

If you are the system administrator, you can limit the number of users allowed
to log on to the system at one time.

1. Press �F2� �A� to open the Actions menu.

2. Press �L� for Limit No. of Sessions.

A dialog box prompts you to type the session limit.

3. Type the number of sessions allowed to run concurrently.

4. Press �F5�
NNNNNNNN
OK to set the session limit.

To display a set of sessions

When you log on to HP Easytime/iX and go to Session Management, you see
all of the sessions currently logged on to the system. You can use the View
menu to restrict your view to a particular set of sessions, for example, those in
a speci�c account.

1. Press �F2� �V� to open the View menu.

2. Press �V� for Set View.

A dialog box prompts you to type a set of sessions. The following example
displays all sessions for all users, in the account FINANCE.
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3. Type the set of sessions that you would like to view.

You can use wildcard characters to de�ne the set.

4. Press �F5�
NNNNNNNN
OK to display the new view.

Only those sessions that you speci�ed are now displayed on your screen.
This new view will last until you exit HP Easytime/iX, or change the view
again.

To reset the view

If you have set the view to show only selected sessions, you can quickly reset it
to display all sessions on the system.

1. Press �F2� �V� to open the View menu.

2. Press �R� for Reset View.

To sort a list of sessions

You can de�ne how sessions are sorted (order in which they are displayed) on
the Session Management screen. When you start HP Easytime/iX and go to
Session Management, sessions are sorted alphabetically by session name. You
can change this to sort sessions, for example, by user.

1. Press �F2� �V� to open the View menu.

2. Choose one of the following settings:

sort by Session Name

7-6 Managing Sessions



sort by User

sort by Account

The sessions on your screen will be sorted according to the setting that
you selected. An asterisk (*) appears in front of the selected setting. This
setting is valid until you exit HP Easytime/iX, or until you change the sort
again.

Managing Files

Files store the information with which you work. Reports, spreadsheets, letters,
and application programs are all �les. If you use the MPE/iX editor to create a
document, this document is a �le.

You can use the File Management screen to manage the �les on your system.
If you cannot perform a task with a particular �le, it may be secured. Ask the
creator of the �le to release it, or see your system administrator for assistance.

The menus at the top of the File Management screen contain all of the tasks
necessary for managing your �les, including the following:

printing �les

copying �les

deleting �les

renaming �les

moving �les

reading �les

releasing and securing �les

displaying a set of �les

sorting a list of �les
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To access File Management

1. Move the cursor to File Management on the Main menu.

2. Press either �F3�, �Return�, or �Spacebar�.

The File Management screen provides the following information about �les on
the system:

name of the �le

account and group where the �le is located

�le code (ASCII or application type)

status (whether the �le is secured or released)

size of the �le in kilobytes

The following �gure illustrates the File Management screen.

Figure 7-2. File Management
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To print a file

When you request a �le to be printed, a copy of the �le (a print �le) is created
and sent to the printer.

1. Select one or more �les from the File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �P� for Print.

A dialog box prompts you for the number of copies.

4. Type the number of copies that you want printed.

5. Press �F5�
NNNNNNNN
OK to print the �le.

If any �les have lockwords, a dialog box prompts you to type them.

The print �le is directed to the HP Easytime/iX printer. You can change
the HP Easytime/iX printer with the task Set Printer on the Options
menu.

To copy files

You can copy �les to the same group, or to another group in your logon
account. You can also copy �les to and from tape for security purposes. If you
want to copy a secured �le, ask the creator of the �le to release it.
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To copy one file

1. Select one �le from the File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �C� for Copy.

A dialog box prompts you for a �le name and group.

4. Type a �le name. You must type a new name if copying the �le to the same
group.

5. Type a group if you want to copy the �le to a group other than your logon
group.

6. Press �F5�
NNNNNNNN
OK to copy the �le.

If the �le has a lockword, a dialog box prompts you to type it.

To copy multiple files

You cannot rename �les when copying more than one at the same time.

1. Select �les to copy.

2. Press �F2� �A� to open the Actions menu.

3. Press �C� for Copy.

A dialog box prompts you for a group.
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4. Type a group if you want to copy the �les to a group other than your logon
group.

5. Press �F5�
NNNNNNNN
OK to copy the �les.

If any �les have lockwords, a dialog box prompts you to type them.

To copy a file from disk to tape (store)

In addition to making regular backups, you can copy �les to tape at any time
for security purposes.

1. Prepare tapes and device.

Refer to the reference information that you received with your tape drive.

2. Load the correct tape in the tape drive.

Caution When you start the store process, any �les currently stored on
this tape will be lost.

3. Select one or more �les from the File Management screen.

4. Press �F2� �A� to open the Actions menu.

5. Press �S� for Store.

A dialog box may prompt you for more information. For example:
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Supply any requested information and press �F5�
NNNNNNNN
OK to continue.

During the store process, HP Easytime/iX displays a monitoring screen
where you can check the progress of the task. Do this by pressing �F5�NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Update Display periodically. During the store process, you cannot use this
terminal for anything else.

If the store is progressing correctly, the monitoring screen displays the
percent complete, for example:

STORE OPERATION IS 25% COMPLETE.

When the store is �nished, the following message is displayed:

Store finished successfully. See report ETSTLST.

When you see this message, the store process is �nished.

6. Press �F8�
NNNNNNNNNNNNNNNNN
Close to close the monitoring screen.

To stop the store process

Press �F7�
NNNNNNNNNNNNNN
Stop .

Press �F5�
NNNNNNNNNNN
Yes to con�rm.

Press �F8�
NNNNNNNNNNNNNNNNN
Close to close the monitoring screen and go back to File

Management.

It can take several minutes for the store process to stop.

7-12 Managing Files



To verify files stored

HP Easytime/iX creates a print �le listing every �le stored and every �le that
the system was not able to store. Check this report to verify that all �les have
been successfully stored on tape. You should keep this report with your tape.

The name of the report �le is ETSTLST. You can view and read the contents of
this �le on the Print File Management screen. This �le can be quite large and
so the status is ON HOLD. Take the �le o� hold if you want to print it.

To set store options

You can set special store options that apply when storing �les. If you are the
system administrator, you can save these options permanently.

1. Press �F2� �O� to open the Options menu.

2. Press �S� for Set Store Options.

A dialog box prompts you to choose store options.

3. Type a �le name, group, and account to save the store report in a �le. If the
�le does not exist, HP Easytime/iX creates it for you.

4. Choose one of the available options.

Refer to \HP Easytime/iX Options," in chapter 4, if you need more
information.
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5. Press �F6�
NNNNNNNNNNNNNN
Save to save the store options permanently.

Or, press �F5�
NNNNNNNN
OK to save the store options for this session only.

To copy a file from tape to disk (restore)

You can restore (copy to disk) one or more �les that have been stored on tape.

1. Prepare tapes and device.

See the reference information that you received with your tape drive.

2. Load the correct tape in the tape drive.

3. Press �F2� �A� to open the Actions menu.

4. Press �T� for Restore.

A dialog box prompts you for the names of the �les that you want to restore
from tape.

5. Type one �le name, group, and account.

Or, specify a set of �les using wildcard characters.

6. Press �F6�
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Add to List .
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If you make a mistake and add a �le to the list that you do not want to
restore, select it and press �F7�

NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Delete from List .

You can repeat steps 5 and 6 to add as many �les as you like to the list.

7. When you have completed the list of �les to be restored from tape, press �F5�NNNNNNNN
OK to continue.

A dialog box may prompt you for more information. For example:

Supply any requested information, and press �F5�
NNNNNNNN
OK to continue.

During the restore process, HP Easytime/iX displays a monitoring screen
where you can check the progress of the task. Do this by pressing �F5�NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Update Display periodically. During the restore process, you cannot use
this terminal for anything else.

When the restore is �nished, the following message is displayed:

Restore finished successfully. See report ETRSTLST.

8. Press �F8�
NNNNNNNNNNNNNNNNN
Close to close the monitoring screen.

To stop the restore process

Press �F7�
NNNNNNNNNNNNNN
Stop .

Press �F5�
NNNNNNNNNNN
Yes to con�rm.

Press �F8�
NNNNNNNNNNNNNNNNN
Close to close the monitoring screen and go back to File

Management.
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It can take several minutes for the restore process to stop.

To verify files restored

HP Easytime/iX creates a print �le listing every �le restored and every �le that
the system was not able to restore. Check this report to verify that all �les
have been successfully restored from tape.

The name of the report �le is ETRSTLST. You can view and read the contents of
this �le on the Print File Management screen. This �le can be quite large and
so the status is ON HOLD. Take the �le o� hold if you want to print it.

To set restore options

You can set special options for restoring �les. If you are the system
administrator, you can save these options permanently.

1. Press �F2� �O� to open the Options menu.

2. Press �R� for Set Restore Options.

A dialog box prompts you to choose restore options.

3. Type a �le name, group, and account to save the restore report in a �le. If
the �le does not exist, HP Easytime/iX creates it for you.
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4. You can choose one or more of the available options.

Refer to \HP Easytime/iX Options," in chapter 4, if you need more
information.

5. Press �F6�
NNNNNNNNNNNNNN
Save to save the restore options permanently.

Or, press �F5�
NNNNNNNN
OK to save the restore options for this session only.

To delete a file

You can use this task to delete unwanted �les from the system.

1. Select one or more �les from the File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �D� for Delete.

4. Press �F5�
NNNNNNNNNNN
Yes to con�rm deletion of �les.

If the �le has a lockword, a dialog box prompts you to type it.

Caution It is important to remember that when you delete a �le, you
cannot get it back, except possibly from a backup tape.

To rename a file

You can rename any �le that you created and that is in your logon account.

1. Select one �le from the File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �M� for Move/Rename.

A dialog box prompts you for a �le name and group. Your logon group is
displayed.
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4. Type a new �le name.

5. Type a group name if you want the renamed �le moved to a group other
than your logon group.

6. Press �F5�
NNNNNNNN
OK to rename the �le.

If the �le has a lockword, a dialog box prompts you to type it.

To move files

You can move �les to and from other groups, but not to and from other
accounts. You can only move �les that you created and that are in your logon
account.

To move one file to another group

1. Select one �le from the File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �M� for Move/Rename.

A dialog box prompts you for a �le name and group. Your logon group is
displayed.

7-18 Managing Files



4. Type the �le name. If you want to give the �le a new name, type a new �le
name; otherwise, type the old �le name.

5. Type a group name if you want to move the �le to a group other than your
logon group.

6. Press �F5�
NNNNNNNN
OK to move the �le.

If the �le has a lockword, a dialog box prompts you to type it.

To move multiple files to another group

When moving more than one �le to another group, you cannot rename them at
the same time.

1. Select �les from the File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �M� for Move/Rename.

A dialog box prompts you for the new group. Your logon group is displayed.
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4. Type a group name if you want to move the �les to a group other than your
logon group.

5. Press �F5�
NNNNNNNN
OK to move the �le.

If any �les have lockwords, a dialog box prompts you to type them.

To read the contents of a file

You can read the contents of any �le that you created or that is released by the
creator. You may also be able to read the contents of a secured �le if you have
read access as provided by MPE/iX security provisions.

1. Select one or more �les from the File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �R� for Read.

If the �le has a lockword, a dialog box prompts you to type it.

The �rst 15 lines of the �le are displayed. You can use the scroll keys to
browse through the contents of the �le.

If you have selected several �les to read, press �F5�
NNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Read Next to display the

contents of the next selected �le.

If the next selected �le has a lockword, a dialog box prompts you to type it.

4. Press �F8�
NNNNNNNNNNNNNNNNN
Close to close the �le when you have �nished reading.

To remove MPE/iX security from a file

You can remove MPE/iX security provisions from any �le that you created.
This means that users in any account can read, copy, delete, or print it.

1. Select one or more �les from the File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �L� for Release.

If any �les have lockwords, a dialog box prompts you to type them.
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To add MPE/iX security to a file

If you previously removed MPE/iX security from a �le, you can re-establish
security provisions with this task. You can secure a �le only if you created it.
Files are automatically secured when they are created.

1. Select one or more �les from the File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �E� for Secure.

If any �les have lockwords, a dialog box prompts you to type them.

To display a set of files

When you log on to HP Easytime/iX and go to File Management, you see all
the �les in your logon group and account. You may want to expand your view
to include �les in another group or to restrict your view to a smaller set of �les
for easier management.

1. Press �F2� �V� to open the View menu.

2. Press �V� for Set View.

A dialog box prompts you to type a set of �les. The following example
displays all �les in the group PUB, in the account SYS.

3. Type the set of �les that you would like to view. You can use wildcard
characters to de�ne a set of �les.
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4. Press �F5�
NNNNNNNN
OK to display the new view.

Only those �les you that speci�ed are now displayed on your screen. This
new view lasts until you exit HP Easytime/iX or change the view again.

To reset the view

If you have set a view of �les, you can quickly reset it to all the �les in your
logon group and account.

1. Press �F2� �V� to open the View menu.

2. Press �R� for Reset View.

To sort a list of files

You can de�ne how �les are sorted (order in which they are displayed) on the
File Management screen. When you start HP Easytime/iX and go to File
Management, �les are �rst sorted alphabetically by account, and then by group
and �le name. You can change this so that �les are �rst sorted, for example, by
�le name.

1. Press �F2� �V� to open the View menu.

2. Choose one of the following settings:

sort by File Name

sort by Group

sort by Account

The �les on your screen will be sorted according to the setting that you
selected. An asterisk (*) appears in front of the selected setting. This setting is
valid until you exit HP Easytime/iX or until you change the sort again.

Additional information about managing �les is provided in the book Task
Reference (B3813-90009).
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Managing Print Files

Print �les are �les that users have requested for printing, but that have not
yet printed. Because the printer can only process one �le at a time, print �les
must be organized in a logical order (queued) when sent to the printer. HP
Easytime/iX sorts print �les according to their status and prints each in turn.

The menus at the top of the Print File Management screen contain all of the
tasks necessary for managing your print �les, including the following:

checking the status of print �les

deleting a print �le

putting a print �le on hold

taking a print �le o� hold

moving a print �le to the top of the queue

reading the contents of a print �le

changing the number of copies

changing the printer

reprinting a print �le

loading and aligning forms

displaying a set of print �les

sorting print �les

The Print File Management screen provides information about all pending
print �les on the system, including the following:

name of the print �le

name of the user who created the print �le

name of the account

printer on which the print �le will be printed

status of the print �le

number of copies requested
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approximate length (in pages) of the print �le

name of the required form (if available)

Figure 7-3. Print File Management

To access Print File Management

1. Move the cursor to Print File Management on the Main menu.

2. Press either �F3�, �Return�, or �Spacebar�.
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To check the status of print files

You can monitor printing on your system by checking the status �eld on the
Print File Management screen.

The status of a print �le can be any one of the following:

This status Means this

CREATE A print �le is being created.

PRINTING The print �le is printing now.

READY The print �le is ready (waiting) to
print.

ON HOLD The print �le has been put on hold.
This means that the print �le cannot
print until you take it o� hold.

LOAD FORM The print �le requires a special form
(kind of paper). Because this print �le
is at the top of the print queue, all
printing on this printer has stopped.
You must load the form before printing
can continue.

ALIGN FORM The print �le requires that you align
the form before printing. Because this
print �le is at the top of the print
queue, all printing on this printer has
stopped. You must align the form
before printing can continue.

PROBLEM There is a problem with the printer.
Check to make sure the printer is
switched on, or check for a paper jam.

UNKNOWN This status indicates a problem with
the printing program. Contact your
system administrator for assistance.
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To delete a print file

If you no longer want a print �le to print, you can delete it from the print
queue.

1. Select one or more print �les from the Print File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �D� for Delete.

4. Press �F5�
NNNNNNNNNNN
Yes to con�rm deletion of the print �le.

To put a print file on hold

You can put a print �le on hold to keep it from printing until you want it to.

1. Select one or more print �les from the Print File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �H� for Put on Hold.

The status of the print �le changes to ON HOLD.

To take a print file off hold

Once you put a print �le on hold, it will not print until you take it o� hold.

1. Select one or more print �les with the status ON HOLD.

2. Press �F2� �A� to open the Actions menu.

3. Press �O� for Take off Hold.

The status of the print �le changes to READY.

To move a print file to the top of the queue

If you need one or more print �les printed quickly, you can move them to the
top of the print queue. These �les are then the next to be printed.

1. Select one or more print �les from the Print File Management screen.

2. Press �F2� �A� to open the Actions menu.
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3. Press �N� for Print Next.

To read the contents of a print file

You can read the contents of a print �le while it is waiting in the print queue.

1. Select one or more print �les from the Print File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �R� for Read.

If the �rst print �le has a lockword, type it.

The �rst 15 lines of the print �le are displayed. You can use the scroll keys
to browse through the contents of the print �le.

If you have selected several print �les to read, press �F5�
NNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Read Next to

display the contents of the next selected print �le.

If the next selected print �le has a lockword, type it.

4. Press �F8�
NNNNNNNNNNNNNNNNN
Close to close the print �le when you have �nished reading.

To change the number of copies of a print file

You can increase or decrease the requested number of copies for a print �le
with this task.

1. Select one or more print �les from the Print File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �C� for Change No. of Copies.
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A dialog box prompts you for the number of copies.

4. Type the number of copies that you want printed.

5. Press �F5�
NNNNNNNN
OK to change the number of copies.

To change the printer for a print file

You can route your print �les to another printer with this task.

1. Select one or more print �les from the Print File Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �P� for Change Printer

A dialog box displays a list of available printers.

4. Select a printer from the list.

5. Press �F5�
NNNNNNNN
OK to change the printer.
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To stop and restart printing of a print file

You can stop (interrupt) a �le that is printing, and start printing again from
the beginning. Use this task to recover after a paper jam.

1. Select the print �le that is currently printing .

2. Press �F2� �A� to open the Actions menu.

3. Press �E� for Reprint.

To load a form

Some print �les need to be printed on a form or special kind of paper. When a
form is needed, the status line on your screen displays the message: LOAD FORM.
You must respond to the request before printing on this printer can continue.

1. Select a print �le with the status Load Form.

2. Press �F2� �A� to open the Actions menu.

3. Press �L� for Load Form.

A dialog box displays information about the kind of form required.

4. Load the correct form in the printer.

Or, choose
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Put on Hold from the dialog box. In this particular case, you

cannot use the Actions menu to put the form on hold.

5. Press �F5�
NNNNNNNN
OK when the form is loaded and you want to start printing.
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To align a form

Some print �les that require a form also require that you align the form before
printing. You would want to be sure that checks, for example, are correctly
aligned before printing a large number of them.

When alignment of a form is needed, the status line on your screen displays the
message: ALIGN FORM. You must respond to this request before printing on this
printer can continue.

1. Select a print �le with the status Align Form.

2. Press �F2� �A� to open the Actions menu.

3. Press �F� for Align Form.

A dialog box prompts you to align the form.

4. Align the form in the paper tray.

Or, choose
NNNNNNNNNNNNNN
Test to �rst print a test line to check alignment.

5. Press �F5�
NNNNNNNN
OK to inform the system that the form is aligned.

To display a set of print files

When you log on to HP Easytime/iX and go to Print File Management, you
see all the print �les under your logon name and account. You may want to
expand your view to include print �les in another account, or restrict it to a
particular set of print �les, for example, those on a speci�c printer.
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1. Press �F2� �V� to open the View menu.

2. Press �V� for Set View.

A dialog box prompts you to type a set of print �les. The following example
displays all print �les for user PAT in account FINANCE.

Setting a View of Print Files

3. Type the set of print �les that you would like to view. You can use wildcard
characters to de�ne a set of print �les.

4. Select one or more printers.

5. Press �F5�
NNNNNNNN
OK to display the new view.

Only those print �les that you speci�ed are now displayed on your screen.
This new view lasts until you exit HP Easytime/iX or change the view
again.

To reset the view

If you have changed your view of print �les, you can quickly reset it to display
all the print �les under your logon name and account.

1. Press �F2� �V� to open the View menu.

2. Press �R� for Reset View.
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To sort a list of print files

When you start HP Easytime/iX and go to Print File Management, print �les
are sorted on your screen by printer. You can change this to sort print �les, for
example, by print �le name or by status.

1. Press �F2� �V� to open the View menu.

2. Choose one of the following settings:

sort by Print File Name
sort by User

sort by Account

sort by Printer

sort by Status

The print �les on your screen will be sorted according to the setting that you
selected. An asterisk (*) appears in front of the selected setting. This setting is
valid until you exit HP Easytime/iX or change the sort again.

Managing Printers

All of the printers con�gured on your system are listed on the Printer
Management screen. The menus at the top of Printer Management screen
contain all of the options necessary for managing your printers, including the
following tasks:

checking the status of printer

enabling a printer

disabling a printer

setting the printer outfence
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To access Printer Management

You must be in system administrator mode to perform Printer Management
tasks.

1. Move the cursor to Printer Management on the Main menu.

2. Press either �F3�, �Return�, or �Spacebar�.

The Printer Management screen provides information about all of the print
devices on the system, including the following:

name of the printer

status of the printer (enabled or disabled)

current outfence set for the printer

The following �gure illustrates the Printer Management screen.

Figure 7-4. Printer Management
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To check the status of a printer

You can check the status of printers on your system from the Printer
Management screen.

The status of a printer can be any one of the following:

This status Means this

ENABLED The system administrator has enabled
the printer. It is available for printing.

DISABLED The system administrator has disabled
the printer. If you route your print �les
to this printer, they will not print until
the printer is enabled.

UNKNOWN This status indicates a problem with
the printer or printing program.
Contact your system administrator for
assistance.

To enable a printer

If you are the system administrator, you can enable a printer. This task
activates a printer and makes it available for printing.

1. Select one or more printers from the Printer Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �E� for Enable.

To disable a printer

If you are the system administrator, you can disable a printer. This task stops
a printer and makes it unavailable for printing.

1. Select one or more printers from the Printer Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �D� for Disable.
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To set the printer outfence

If you are the system administrator, you can set the printer outfence. By
increasing the outfence, you can prevent �les from printing. The outfence can
be any value from 1 to 14. If the outfence is set at 5, for example, then only
those print �les with a priority of 6 or higher can print.

1. Select one or more printers from the Printer Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �O� for Set Outfence.

A dialog box prompts you to type the new outfence.

4. Type the outfence number.

5. Press �F5�
NNNNNNNN
OK to set the outfence.

To set the HP Easytime/iX printer

You can specify a printer for all printing initiated in HP Easytime/iX, for
example, print �les, listings of system errors, or backup reports. Unless
saved by the system administrator, this setting is valid until you exit
HP Easytime/iX.

1. Press �F2� �O� to open the Options menu.

2. Press �P� for Set Printer

A dialog box prompts you to select a printer.

Managing Printers 7-35



3. Select a printer from the list.

4. If you are the system administrator, you can press �F6�
NNNNNNNNNNNNNN
Save to save this

setting permanently.

Or, press �F5�
NNNNNNNN
OK to set the printer for this session only.
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Managing Jobs

Much of the work that you do on the system can be accomplished with jobs .
A job is a �le that contains commands that you would normally type at the
keyboard during an interactive session. When you start the job, the computer
interprets and executes these commands automatically. No further user input is
necessary.

HP Easytime/iX sorts jobs according to status and runs each in turn. These
jobs are listed (queued) on the Job Management screen where you can manage
them and monitor their progress.

The menus at the top of the Job Management screen contain all of the options
necessary for managing your jobs, including the following tasks:

checking the status of jobs

starting jobs

deleting jobs

scheduling jobs

putting jobs on hold

taking jobs o� hold

suspending and resuming jobs

moving a job to the top of the queue

changing the status of jobs

limiting the number of jobs

setting the jobfence

displaying a set of jobs

sorting a list of jobs
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The Job Management screen provides the following information about jobs on
the system:

name of the job

name and account of the user under which the job is logged on

name of the program that the job is running (if there is one)

current status of the job

date and time when the job started or is scheduled to start

The following �gure illustrates the Job Management screen.

Figure 7-5. Job Management

To access Job Management

1. Move the cursor to Job Management on the Main menu.

2. Press either �F3�, �Return�, or �Spacebar�.
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To check the status of jobs

You can monitor jobs on your system by checking the status �eld on the Job
Management screen.

The status of a job can be any one of the following:

This status Means this

ACTIVE The job is running now.

READY The job is ready and waiting to run.
The maximum number of jobs that can
run at one time has been reached. This
job will run when one of the active jobs
is �nished.

SCHED The job is scheduled to run at a later
date and time. The start date and time
is displayed on the Job Management
screen.

ON HOLD The job has been put on hold. A job
that is on hold cannot run until you
take it o� hold.

SUSPEND Someone has interrupted (suspended)
this job while it was running. The task
Resume can be used to start it again
(from the place where it was stopped).

To start a job

When you start a job, you introduce it to the system.

1. Press �F2� �A� to open the Actions menu.

2. Press �S� for Start.

A dialog box prompts you for a job �le name.

Managing Jobs 7-39



3. Type the name of the job �le in the Job File Name �eld.

If the job �le is in a group or account other than your logon group and
account, type them.

If the �le has a lockword, type it.

4. Press �F5�
NNNNNNNN
OK to start the job.

If the job accesses accounts, groups, or users that require passwords, HP
Easytime/iX prompts you to type them.

To delete (abort) a job

If a job cannot continue because of an error, you may need to delete the job
and restart. You can delete any active job, or job that is waiting in the job
queue.

1. Select one or more jobs from the Job Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �D� for Delete.

4. Press �F5�
NNNNNNNNNNN
Yes to con�rm deletion of jobs.
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To schedule a job

You can schedule a job to run at a later date or time, for example, after you
have gone home for the evening. If you have a job that updates a database,
or other �les, you can schedule it to run at night when the �les are not being
used.

1. Press �F2� �A� to open the Actions menu.

2. Press �S� for Start.

A dialog box prompts you for a job �le name, start date, and time.

3. Type the name of the job �le in the Job File Name �eld.

If the job �le is in a group or account other than your logon group and
account, type them.

If the �le has a lockword, type it.

4. Type the start date and time for the job.

5. Press �F5�
NNNNNNNN
OK to schedule the job.

The job appears in the job queue with a status of SCHED and starts at the
scheduled date and time.

Managing Jobs 7-41



To put a job on hold

If a job in the job queue is not yet running, you can put it on hold to delay its
running.

1. Select one or more jobs with a status of Ready.

2. Press �F2� �A� to open the Actions menu.

3. Press �H� for Put on Hold.

The job appears in the job queue with a status of ON HOLD and does not start
until you take it o� hold.

To take a job off hold

If one or more jobs are on hold, you must take them o� hold before they can
run.

1. Select one or more jobs with the status On Hold.

2. Press �F2� �A� to open the Actions menu.

3. Press �O� for Take off Hold.

The job appears in the job queue with a status of ACTIVE or READY.

To suspend a job

The task suspends (interrupts) a job in progress. If system resources are
limited, you can speed up the processing of some jobs by suspending other, less
critical jobs.

1. Select one or more jobs with the status Active.

2. Press �F2� �A� to open the Actions menu.

3. Press �P� for Suspend.

The job stops, and its status changes to SUSPEND. The job does not continue
until you resume processing.
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To resume a suspended job

1. Select one or more jobs with the status Suspend.

2. Press �F2� �A� to open the Actions menu.

3. Press �R� for Resume.

The job continues to run from the point where it was suspended.

To move a job to the top of the queue

If you are the system administrator, you can move a job to the top of the
queue by changing the job status. It becomes the next job to run.

1. Select one or more jobs from the Job Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �N� for Run Next.
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To limit the number of jobs

If you are the system administrator, you can limit the number of jobs running
at one time on the system. If the job limit is set at 5, only the �rst �ve jobs
can begin processing. Subsequent jobs have a status of READY and wait in the
job queue until one of the active jobs ends.

1. Press �F2� �A� to open the Actions menu.

2. Press �L� for Limit No. of Jobs.

A dialog box prompts you to type the job limit.

3. Type the number of jobs allowed to run concurrently.

4. Press �F5�
NNNNNNNN
OK to set the job limit.
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To set the jobfence

If you are the system administrator, you can restrict which jobs are allowed to
execute.

The jobfence is the minimum priority level that a job must exceed in order to
run. The jobfence can be any value from 0 to 14. If the jobfence is set at 8, for
example, then only those jobs with a priority of 9 or higher can run.

1. Press �F2� �A� to open the Actions menu.

2. Press �F� for Set Jobfence.

A dialog box prompts you to type the jobfence number.

3. Type the jobfence.

4. Press �F5�
NNNNNNNN
OK to set the jobfence.

To display a set of jobs

When you log on to HP Easytime/iX and go to Job Management, you see all
the jobs currently logged on to the system. You can restrict your view to a
particular set of jobs, for example, those in a speci�c account.

1. Press �F2� �V� to open the View menu.

2. Press �V� for Set View.

A dialog box prompts you to type a set of jobs. The following example
displays all jobs for user PAT, in account MGR.
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3. Type the set of jobs that you would like to view. You can use wildcard
characters to de�ne a set of jobs.

4. Press �F5�
NNNNNNNN
OK to display the new view.

Only those jobs that you speci�ed are now displayed on your screen. This
new view will last until you exit HP Easytime/iX or until you change the
view again.

To reset the view

If you have changed your view of jobs, you can quickly reset it to display all of
the jobs on the system.

1. Press �F2� �V� to open the View menu.

2. Press �R� for Reset View.

To sort a list of jobs

When you start HP Easytime/iX and go to Job Management, jobs are sorted
on your screen by status (the order in which they will run). You can change
this to sort jobs, for example, by user.
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1. Press �F2� �V� to open the View menu.

2. Choose one of the following settings:

sort by Job Name

sort by User

sort by Account

sort by Status

The jobs on your screen are sorted according to the setting that you selected.
An asterisk (*) appears in front of the selected setting. This setting is valid
until you exit HP Easytime/iX or change the sort again.

Managing Backups

Choosing a good backup plan and scheduling regular backups are important to
the e�cient operation of your system. Regularly scheduled backups reduce
the time needed to perform backups and guarantee that the most recent
information is always available to users.

If you are responsible for managing backups on your system, your
responsibilities include the following:

designing a backup schedule

scheduling and performing regular backups

storing and maintaining backup tapes

To access Backup Management

1. Move the cursor to Backup Management on the Main menu.

2. Press either �F3�, �Return�, or �Spacebar�.

The Backup Management screen displays the current backup schedule and
provides a history of recent backups on the system including the following:

kind of backup (full or partial)

date the backup was performed
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number of tapes required for the backup

device on which the backup was performed

time needed to complete the backup

The following �gure illustrates the Backup Management screen.

Figure 7-6. Backup Management
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To design a backup schedule

You can perform two kinds of backups with HP Easytime/iX:

full backups

partial backups

A full backup copies all user �les on the system whether or not the information
has changed since the last full backup. A partial backup copies only those �les
that have changed since the last full backup. Your backup schedule should
include both. A typical backup schedule allows for one full backup one day a
week, and a partial backup on each remaining work day.

The following �gure illustrates such a backup schedule on the Backup
Management screen.

Figure 7-7. Backup Management Screen

If you use such a schedule, you will lose no more than 24 hours' worth of
information should the system fail.
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To schedule backups

With HP Easytime/iX, you can set up your backup schedule and then use the
Backup Management screen to review backup information.

Note Your scheduled backup will start and complete automatically
only under the following conditions:

A write-enabled tape is loaded.

Your tape device is con�gured for autoreply. Refer to
\Backing Up the System" in Chapter 6 and read the
instructions for performing an unattended, scheduled backup.

The �les to be backed up �t on one tape; otherwise, someone
must load the next one.

Perform the following steps to schedule backups:

1. From the Backup Management screen, select one or more days of the week.

For example, Monday through Thursday.

2. Press �F2� �A� to open the Actions menu.

3. Press �S� for Schedule Backup.

A dialog box prompts you for further scheduling information.
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4. Choose the type of backup that you want (full or partial).

5. Type the time that you want the backup to start.

It is a good idea to schedule backups at the end of the workday when users
are no longer using the system. Also, schedule the backup for the same time
every day so that users know when to expect it and can plan accordingly.

6. Select a backup device.

7. Select a backup printer (for backup report).

If you want to save the backup report in a �le, you have the option of
entering a �le name, group, and account where the report will be saved.

8. Press �F5�
NNNNNNNN
OK to schedule the backup.

When the scheduled backup starts, HP Easytime/iX sets the job and session
limits to 1 to prevent any new sessions or jobs from starting.
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To cancel a scheduled backup

You can cancel a scheduled backup at any time before it starts.

1. From the Backup Management screen, select one or more scheduled backups.

2. Press �F2� �A� to open the Actions menu.

3. Press �D� for Delete Scheduled Backup.

4. Press �F5�
NNNNNNNNNNN
Yes to cancel the scheduled backup.

To perform backups

In addition to your regularly scheduled backups, you can perform a full or
partial backup whenever needed. Before you start a backup, send a message
warning users to log o� the system, for example:

Backup will begin in 10 minutes. Please finish and log off.

1. Prepare your backup tapes and device.

See the reference information that you received with your tape drive.

2. Load the correct tape in the tape drive.

3. Press �F2� �A� to open the Actions menu.

4. Press �F� for Perform Full Backup.

Or, press �P� for Perform Partial Backup.

If there are active jobs and sessions, a dialog box prompts you to con�rm
that you want to continue. Any �les currently accessed by the active jobs
and sessions are not backed up. Press �F5�

NNNNNNNNNNN
Yes if you want to continue with

the backup.

Once the backup begins, HP Easytime/iX sets the job and session limits to
1 to prevent any new sessions or jobs from starting.

Caution If your system is con�gured for autoreply, the backup starts
immediately. Any �les stored on the tape that you loaded will
be lost.
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If your system is not con�gured for autoreply, a dialog box prompts you for
more information. For example:

Supply the requested information and press �F5�
NNNNNNNN
OK to continue with the

backup.

Or, press �F7�
NNNNNNNNNNNNNN
Stop to stop the backup.

During the backup process, HP Easytime/iX displays a monitoring screen
where you can check the progress of the backup. Do this by pressing �F5�NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Update Display periodically. During the backup process, you cannot use
this terminal for anything else.

If the backup is progressing correctly, the monitoring screen displays the
percent complete, for example:

STORE OPERATION IS 25% COMPLETE.

When the backup is �nished, the following message is displayed:

Backup finished successfully. See report ETBUPLST.

When you see this message, the backup process is �nished.

5. Press �F8�
NNNNNNNNNNNNNNNNN
Close to close the monitoring screen.
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To stop the backup process

1. Press �F7�
NNNNNNNNNNNNNN
Stop .

2. Press �F5�
NNNNNNNNNNN
Yes to con�rm.

3. Press �F8�
NNNNNNNNNNNNNNNNN
Close to close the monitoring screen and go back to Backup

Management.

It can take several minutes for the backup process to stop.

To verify backup information

HP Easytime/iX prints a backup report listing every �le backed up and every
�le that the system was not able to back up. Be sure to check this report to
verify that all �les have been successfully saved on tape. You should keep this
report with your tape.

The name of the report �le is ETBUPLST. You can view and read the contents of
this �le on the Print File Management screen. This �le can be quite large and
so the status is ON HOLD. Take the �le o� hold if you want to print it.

To set the backup options

You can specify special default options that apply when backing up �les. If you
are the system administrator, you can save these options permanently.

1. From the Backup Management screen, press �F2� �O� to open the
Options menu.

2. Press �B� for Set Backup Options.

A dialog box prompts you for more information.
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3. Type a �le name, group, and account for the backup report. If the �le does
not exist, HP Easytime/iX creates it for you.

4. If you are the system administrator, you can press �F6�
NNNNNNNNNNNNNN
Save to save this

setting permanently.

Or, press �F5�
NNNNNNNN
OK to save the backup options for this session only.

To set the backup device

You can specify the backup device to be used when performing backups or
storing and restoring �les. If you are the system administrator, you can save
these options permanently.

1. From the Backup Management screen, press �F2� �O� to open the
Options menu.

2. Press �D� for Set Backup Device.

A dialog box displays a list of available backup devices.
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3. Select a device from the list.

4. If you are the system administrator, you can press �F6�
NNNNNNNNNNNNNN
Save to save this

setting permanently.

Or, press �F5�
NNNNNNNN
OK to save the backup device for this session only.

Managing Console Messages

You can monitor the system from the Console Management screen and respond
to requests from the system. The menus at the top of the Console Management
screen contain all of the options necessary for managing your console messages
and requests, including the following tasks:

replying to requests

printing messages and requests

displaying a set of messages and requests

To access Console Management

1. Move the cursor to Console Management on the Main menu.

2. Press either �F3�, �Return�, or �Spacebar�.

The Console Management screen displays the following information:

messages from the system

7-56 Managing Console Messages



requests that require a response

time the request or message was sent

creator of the request

The following �gure illustrates the Console Management screen.

To move between requests and messages

Press �Tab�.

Managing Console Messages 7-57



To reply to a request

Some tasks, for example, backing up the system or storing a �le on tape,
require additional user input after you start them. HP Easytime/iX prompts
you to load or remove tapes as needed. These prompts are called requests.

1. Select one request from the Console Management screen.

2. Press �F2� �A� to open the Actions menu.

3. Press �R� for Reply to Request.

A dialog box displays the system request and prompts you to reply.

4. Read the request and follow the instructions on the screen.

5. Press �F5�
NNNNNNNN
OK to continue.

Or, press �F8�
NNNNNNNNNNNNNNNNNNNN
Cancel to postpone your reply until later.

Important

Some request dialog boxes have a
NNNNNNNNNNNNNN
Stop option. If you press �F7�

NNNNNNNNNNNNNN
Stop , you

abort a task in progress (for example, backing up the system, or storing a �le
on tape) and delete the request from the system.
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To print messages and requests

1. Press �F2� �A� to open the Actions menu.

2. Press �P� for Print Requests/Messages.

All messages and requests will be printed on the HP Easytime/iX printer.
The name of the print �le is ETCONLST.

To display a set of console messages

When you log on to HP Easytime/iX and go to Console Management, you can
read the last 1,000 messages that the system sent and any pending requests.

If you do not want to see all messages and requests on the system, you can
restrict your view to a particular set of messages and requests, for example,
those for a speci�c user or account.

1. Press �F2� �V� to open the View menu.

2. Press �V� for Set View.

A dialog box prompts you to type a set of messages. The following example
displays messages and requests for all users in account SYS.

3. Type a set of user names and accounts. You can use wildcard characters to
de�ne the set.

4. Press �F�
NNNNNNNN
OK to display the new view.
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Only those messages that you speci�ed are now displayed on your screen.
This new view lasts until you exit HP Easytime/iX or until you change the
view again.

To reset the view

If you have set a view of messages and requests, you can quickly reset it to
view all messages and requests on the system with this task.

1. Press �F2� �V� to open the View menu.

2. Press �R� for Reset View.

Customizing HP Easytime/iX

As the system manager, you can use the setup program to customize HP
Easytime/iX. This program is optional. HP Easytime/iX arrives set up for
you. You can use it as it is or change it to meet your particular needs.

This section explains how to use the setup program, including the following
tasks:

starting the setup program

disabling and enabling functions

choosing a startup screen

canceling a startup screen

setting defaults

saving the setup �le
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To start the setup program

You need system manager capabilities to customize HP Easytime/iX with the
setup program.

1. Log on to the system as MANAGER.SYS.

2. From the system prompt, type:

:RUN ETSETUP.PUB.SYS �Return�

The HP Easytime/iX Setup screen is displayed. The following �gure illustrates
the setup screen.

Figure 7-8. HP Easytime/iX Setup Screen
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To disable a function

When you receive HP Easytime/iX, all functions are enabled and any user
can access them. The setup screen displays a list box containing all of the
HP Easytime/iX functions.

You can disable any function that you do not want users to access.

1. Select one or more functions.

2. Press �F2� �A� to open the Actions menu.

Figure 7-9. Actions menu

3. Press �D� for Disable Function.
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To enable a function

You can use the setup program at any time to enable functions that you have
disabled.

1. Select one or more functions.

2. Press �F2� �A� to open the Actions menu.

3. Press �E� for Enable Function.

To set backup defaults for scheduled backups

With this task, you can specify a job to run immediately before a scheduled
backup and a job to run immediately after a scheduled backup.

For example, you can run a job that deletes (aborts) active sessions and speci�c
jobs before a scheduled backup. After the backup, you can run another job
that restarts the jobs and processes that you stopped previously.

1. Press �F2� �A� to open the Actions menu.

2. Press �B� for Set Backup Defaults.

A dialog box prompts you for more information.

3. Type the �le name, group, and account of the job to start before the
scheduled backup.
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Use the �Tab� key to move from �eld to �eld.

4. Type the �le name, group, and account of the job to start after the
scheduled backup.

5. Press �F5�
NNNNNNNN
OK to set the backup defaults.

The backup defaults that you selected are displayed on the HP Easytime/iX
Setup screen.

To set the default for console messages and requests

With HP Easytime/iX, you do not need a dedicated terminal to view and
respond to console messages. You can monitor console messages from the
Console Management screen within HP Easytime/iX.

You can display messages and requests on both the system console and in
HP Easytime/iX, or in HP Easytime/iX only.

1. Press �F2� �A� to open the Actions menu.

2. Press �C� for Set Console Defaults.

3. Select the option that you want.

An asterisk (*) marks the selected option.

If you choose to display messages on both the system console and in
HP Easytime/iX, you will not be able to use the system console for any
other application, including HP Easytime/iX.

4. Press �F5�
NNNNNNNN
OK to set the console default.
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The option that you selected is displayed on the HP Easytime/iX Setup
screen.

To choose a startup screen

HP Easytime/iX is con�gured to display the Main menu when started. You can
change this to display a di�erent screen, for example, Print File Management,
when starting the program.

1. Select one function.

2. Press �F2� �A� to open the Actions menu.

3. Press �U� for Use as Startup.

This screen is marked (Startup) on the HP Easytime/iX Setup screen.

To cancel a startup screen

If you choose a screen as the startup screen for HP Easytime/iX, you can
cancel it by enabling the function again.

1. Select the function marked (Startup).

2. Press �F2� �A� to open the Actions menu.

3. Press �E� for Enable Function.

This screen is no longer the startup screen, and the Main menu will be used
instead.

To save the setup defaults

After you have completed customizing HP Easytime/iX, you must save the
setup �le.

1. Press �F2� �A� to open the Actions menu.

2. Press �S� for Save Setup File.
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To exit the setup program

1. Press �F8�
NNNNNNNNNNNNNN
Exit to exit the HP Easytime/iX Setup screen.

2. Press �F5�
NNNNNNNNNNN
Yes to con�rm and exit.

Solving Problems

This section lists problems that you may encounter when working with
HP Easytime/iX, possible causes for the problem, and steps for recovery.

To respond to print file problems

Problem Print �le is not printing.

Cause Print �le needs a form (or standard paper) loaded.

Action Check the Print File Management screen for the name of the
form, and load it on the printer. Perform the task Load Form

to inform the system that form has been loaded.

Cause Form needs alignment.

Action Check to see that the form is correctly aligned, and perform
the task Align Form from the Print File Management screen.

Cause Print �le has been put on hold.

Action Perform the task Take off Hold from the Print File
Management screen.
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To respond to printer problems

Problem Nothing is printing on a printer.

Cause Printer is not ready.

Action Check the printer to make sure that it is plugged in, switched
on, and online. Check for a paper jam, or check if paper needs
to be loaded.

Cause Printer is not enabled.

Action The system administrator should enable the printer.

Cause Printer outfence is set too high.

Action The system administrator should check the outfence.

To respond to session problems

Problem Terminal is not responding.

Cause Various causes.

Action Delete session, and log on again.

Action Press �Shift� + �Reset�.

Problem Screen display is corrupted.

Cause Communication problem between terminal and computer.

Action Press �Clear display�.
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Problem User cannot type data in a �eld.

Cause Input �eld is full and you are in insert mode.

Action Press Insert char again to change to overwrite mode.
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8

HP Easytime/iX Reference

This chapter provides reference information about the following topics:

requests and messages from the system

cursor movement, editing, selection, and function keys

�eld de�nitions for each screen

HP Easytime/iX options

wildcard character sets
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Requests and Messages from the System

This section provides a list of requests and messages that you may encounter
when working with HP Easytime/iX. The three kinds of messages displayed in
HP Easytime/iX are:

requests prompting you for more information

messages resulting from an error (requires a corrective action)

messages about what is happening on the system

The following �gure illustrates messages and requests as displayed on the
Console Management screen.

Figure 8-1. Messages and Requests
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To respond to requests

Requests are messages from the system that prompt you �rst to do something,
and then to con�rm your actions by replying, either from the Console
Management screen or from a dialog box. You should respond immediately
when there is a request pending on the system. A process or task, such as a
backup, cannot continue until you supply the required information.

This section provides a list of common requests, causes for the request, and the
required actions.

Request device (ldev n) FORMS ALIGNED OK (Y/N) ?

Cause This message occurs when a form has been loaded.

Action Check to see that the form is correctly aligned, and perform
the task Align Form from the Print File Management screen.

Request device (ldev n) IS PAPER AT TOP OF FORM (Y/N?) ?

Cause This message occurs at the beginning of a print job.

Action Check to see that the paper is at the top of form and perform
the task Align Form from the Print File Management screen.

Request Is device (ldev n)WRITE ENABLED (Y/N) ?

Cause This message occurs during a backup or when storing �les to
tape.

Action Con�rm that the tape is write enabled and reply to the
request. You can store information only on a tape that is write
enabled.
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Request LOAD tape ON device (ldev n).

Cause This message occurs during a backup, store, or restore process
when you need to load a tape.

Action Load the tape indicated in the correct tape drive, and reply to
the request.

Request SELECT DEVICE NO. OF CLASS classname ON WHICH
YOU LOADED tape.

Cause This request occurs during a backup, store, or restore process
when you need to load a tape.

Action Load the tape indicated in the correct tape drive and reply to
the request.

Request SP #ldev n IS #job number ; �le name ON device (ldev n)
(Y/N)?

Cause This request occurs when a print �le requires a form or
standard paper to be loaded.

Action Check the Print File Management screen for the kind of paper
required, and perform the task Load Form.
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To respond to messages

You can monitor messages to keep informed about activity on your system, for
example, users or jobs logging on and o�, disk storage, or other resource usage.
Some messages are caused by an error and require a corrective action on your
part.

This section provides a list of system messages. When the message is caused
by an error, possible causes for the error and suggestions for recovery are also
included.

Message device (ldev n) IS NOT WRITE ENABLED.

Cause This message occurs during a backup, or when storing or
restoring �les. It indicates that the tape is not write enabled.

Action Enable the tape for writing.

Message device (ldev n) MUST BE ONLINE BEFORE REPLYING.

Cause This message occurs if the tape drive is not online during a
backup, or when storing or restoring �les.

Action Set the tape drive online.

Message device (ldev n) NOT READY.

Cause This message occurs when there is a problem with a printer or
tape drive.

Action Check the device to make sure that it is plugged in, powered
on, and online. If the device is a printer, check for a paper jam
and that the printer is not out of paper.

Message FORMS ON device (ldev n) : forms message.

Cause This message occurs when a print �le requires a form.
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Action Check the Print File Management screen for the kind of form
required and perform the task Load Form.

Message LOGOFF ON device (ldev n).

Cause User or job indicated has logged o� this device.

Action No action required.

Message LOGON FOR: user,group.account ON device (ldev n).

Cause User or job indicated has logged on to this device.

Action No action required.

Message LOAD MEDIA media n FOR RESTORE ON device (ldev n).

Cause This message occurs when restoring �les from tape. Indicates
that the end of the tape has been reached.

Action Load the next tape in the tape drive.

Message LOAD NEXT MEDIA FOR RESTORE ON device (ldev n).

Cause This message occurs when restoring �les from tape. Indicates
that the end of the tape has been reached.

Action Load the next tape in the tape drive.

Message LOAD MEDIA media n FOR STORE ON device (ldev n).

Cause This message occurs during a backup or when storing �les to
tape. Indicates that the end of the tape has been reached.

Action Load the next tape in the tape drive.

Message LOAD NEXT MEDIA FOR STORE ON device (ldev n).
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Cause This message occurs during a backup or when storing �les to
tape. Indicates that the end of the tape has been reached.

Action Load the next tape in the tape drive.

Message STANDARD FORMS ON device (ldev n) : forms message .

Cause This message occurs when a print �le requires a standard
paper (after a form has printed).

Action Load standard paper in the printer, and perform the task Load

Form from the Print File Management screen.

Message COMPLETE.

Cause This message occurs during a scheduled backup and indicates
the current status of the backup process.

Action No action required.

Message UNLABELED VOLUME LOADED ON device (ldev n).

Cause This message occurs when an unlabeled tape is loaded in the
tape drive.

Action No action required.

Message VOLUME WITH LABEL label LOADED ON device (ldev n).

Cause This message occurs during a backup, store, or restore process
when you use labeled tapes. Tape indicated is currently loaded
on this tape drive.

Action No action required. HP Easytime/iX cannot use labeled tapes.
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Using the Keyboard

This section provides tables to identify the keys that you use when performing
HP Easytime/iX tasks. The keys that you use will vary depending on the kind
of terminal that you have.

Cursor movement keys

You can use the following keys to move in HP Easytime/iX:

To scroll Press these keys

Up one line ���

Down one line �	�

Up one page �Scroll Up� or �Shift� + ���

Down one page �Scroll Down� or �Shift� + �	�

Right one page �Next�

Left one page �Prev�

To the top of the list ���

To the bottom of the list �Shift� + ���

To move in a dialog box Press these keys

To the next �eld �Tab�

To the previous �eld �Shift� + �Tab�

One character right ���

One character left ���
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Editing keys

You can use any of the following keys to edit information that you are typing
on the screen:

To do this Press these keys

Go to insert mode �Insert char�

Exit insert mode �Insert char� again

Delete a character �Delete char�

Delete one character to the left �Backspace�

Delete all characters �Delete line�

Delete all characters to the
right

�Clear line�

Selection keys

You can use any of the following keys to select items:

To do this Press these keys

Select one item �F3�, �Return�, or �Spacebar�

Cancel selection of one item �F3�, �Return�, or �Spacebar�

Select all items �F2� �/�

Cancel selection of all items �F2� �n�

Select �rst item in a range �F2� �F3�

Select last item in a range �F2� �F3�
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Function Keys

This section describes the function keys used in HP Easytime/iX for the many
tasks that you can perform. Both the function labels and the keys are listed.
Not every function key is available on every screen or dialog box. The labels
change according to the dialog box or screen where you are working; however, a
function key label always refers to the same key wherever it appears.

Pressing this key Does this

NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Add to List �F6� In a dialog box,

NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Add to List moves the

indicated �le to the list box.
NNNNNNNNNNNNNNNNNN
Cancel �F8� In a dialog box,

NNNNNNNNNNNNNNNNNN
Cancel cancels the task and

closes the dialog box.
NNNNNNNNNNNNNNNN
Close �F8� On a screen,

NNNNNNNNNNNNNNNN
Close closes the active screen and

displays the previous one.

In a help window,
NNNNNNNNNNNNNNNN
Close closes the window.

NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Delete from List �F7� In a dialog box,

NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Delete from List deletes the

selected �le from the list box.
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Fast Select �F2� On a screen,

NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Fast Select (and then an

underlined letter) opens the corresponding
menu.

In a dialog box,
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Fast Select (and then an

underlined letter) selects and activates a push
button.

NNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Field Help �F1� In HP Easytime/iX,

NNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Field Help displays help

about the current cursor object, for example, a
data-entry �eld or a menu item.

NNNNNNN
No �F8� In a con�rmation box,

NNNNNNN
No cancels a task and

closes the box.
NNNNNNN
OK �F5� In a dialog box,

NNNNNNN
OK con�rms and completes a

task, and closes the dialog box.
NNNNNNNNNNNNN
Read �F5� In a help window,

NNNNNNNNNNNNN
Read displays help

information about the selected topic.
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Pressing this key Does this

NNNNNNNNNNNNNNNNNNNNNNNNNN
Read Next �F5� In a �le,

NNNNNNNNNNNNNNNNNNNNNNNNNN
Read Next displays the contents of

the next selected �le.
NNNNNNNNNNNNN
Save �F7� In a dialog box,

NNNNNNNNNNNNN
Save saves the selected

options.
NNNNNNNNNNNNNNNNNN
Select �F3� In a list of values,

NNNNNNNNNNNNNNNNNN
Select selects the value on

which the cursor rests.

In a dialog box,
NNNNNNNNNNNNNNNNNN
Select selects the push button

on which the cursor rests.

In a menu,
NNNNNNNNNNNNNNNNNN
Select selects the menu item on

which the cursor rests.

In a list box,
NNNNNNNNNNNNNNNNNN
Select and then �/� selects all

items in the list.
NNNNNNNNNNNNNNNNNN
Select and then �n� cancels the selection of all
items in the list.

NNNNNNNNNNNNN
Stop �F7� In a dialog box,

NNNNNNNNNNNNN
Stop stops a task in progress,

for example, a backup.
NNNNNNNNNNNNN
Test �F6� In a dialog box (when aligning forms),

NNNNNNNNNNNNN
Test

prints a test line.
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
To/From Menu Bar �F4� In HP Easytime/iX,

NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
To/From Menu Bar moves

the cursor to or from the menu bar.

In a menu,
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
To/From Menu Bar closes the menu

and exits the menu bar.
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Update Display �F5� In HP Easytime/iX,

NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Update Display updates

the terminal display with the most current
data. The time of the last update is always
displayed on the status line of your screen.

NNNNNNNNNN
Yes �F5� In a con�rmation box,

NNNNNNNNNN
Yes con�rms and

completes a task, and closes the box.
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Defining HP Easytime/iX Screens

This section illustrates and provides �eld names and de�nitions for the
following HP Easytime/iX screens:

Session Management

File Management

Print File Management

Printer Management

Job Management

Backup Management

Console Management
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Session Management

This section illustrates and de�nes the �elds that are displayed on the
Session Management screen and that you encounter when performing Session
Management tasks.

Figure 8-2. Session Management Screen

Field name Means this

Session Name Name of the session. This can be speci�ed when
logging on.

User Name of the user who started the session.

Account Logon account of the user who started the
session.

Program Name of the program that the session is
running (if there is one).

Start Date/Time Date and time when a session started.
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File Management

This section illustrates and de�nes the �elds that are displayed on the File
Management screen and that you encounter when performing File Management
tasks.

Figure 8-3. File Management Screen

Field name Means this

File Name Name of the �le. A �le name can contain a
maximum of eight alphanumeric characters and
must begin with a letter.

Group Group where the �le is located. Files located in
the PUB group are usually �les that all users
share. Files in other groups are often private
�les for users in the group only.
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Field name Means this

Account Account where the �le is located.

Code Indicates the kind of �le, for example, ASCII or
WDOC.

Status Shows current �le security (whether �le is
secured or released).

Size Shows size of the �le in kilobytes. If a �le is
smaller than one kilobyte, <1 is displayed.
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Print File Management

This section illustrates and de�nes �elds that are displayed on the Print
File Management screen and that you encounter when performing Print File
Management tasks.

Figure 8-4. Print File Management

Field name Means this

Print File Name Name of the �le to be printed.

User User who created the print �le.

Account Logon account of the user who created the print
�le.

Printer The identi�cation name or number of the
printer where the �les will be printed.
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Field name Means this

Status The status of a print �le may be any one of the
following:

CREATE The print �le is being created.

PRINTING The print �le is currently printing.

READY The print �le is ready (waiting) to print.

ON HOLD The print �le is on hold. Cannot print until you
take it o� hold.

LOAD FORM A form is required and must be loaded before
printing on this printer can continue.

ALIGN FORM A form has been loaded and requires alignment.

PROBLEM There is a problem with the printer or with a
print �le. Check to make sure that the printer
is switched on, or check for a paper jam.

UNKNOWN Cause of the problem is unknown. Contact your
system administrator for assistance.

No. of Copies Shows number of copies that will be printed.

Length Shows the approximate length (in pages) of
each print �le.

Forms Indicates the name of the form, if one is
required.
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Printer Management

This section illustrates and de�nes the �elds that are displayed on the
Printer Management screen and that you encounter when performing Printer
Management tasks.

Figure 8-5. Printer Management Screen

Field name Means this

Printer Identi�cation name of the printer. Usually, each
printer has one name assigned to it. In some
cases, several printers may be grouped together
under one name.

Status Printer status can be any one of the following:

ENABLED The system administrator has enabled the
printer. It is available for printing.

DISABLED The system administrator has disabled the
printer. If your print �les are routed to this
printer, they do not print until the printer is
enabled.
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Field name Means this

UNKNOWN Cause of problem is unknown. Contact your
system administrator for assistance.

Outfence The outfence is a number assigned to each
printer on the system by the system
administrator. The outfence is the minimum
priority that a print �le must exceed in order to
print.

The outfence can be any value from 1 to 14. If
the outfence is set at 5, for example, only those
print �les with a priority of 6 or higher can
print. By adjusting the outfence higher or
lower, the system administrator can control
printing on speci�c printers.
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Job Management

This section illustrates and de�nes the �elds that are displayed on the Job
Management screen and that you encounter when performing Job Management
tasks.

Figure 8-6. Job Management Screen

Field Name Means this

Job Name An identi�cation name given to each job when
it is started or scheduled.

User User name under which the job is logged on.

Account Account under which the job is logged on.

Program The name of the program that the job is
running (if there is one).
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Field name Means this

Status The status of a job can be any one of the
following:

ACTIVE The job is running now.

READY The job is ready (waiting) to run.

SCHED The job is scheduled to run at a later date and
time.

ON HOLD The job has been put on hold. It does not run
until you take it o� hold.

SUSPEND Someone has suspended (interrupted) this job
while it was running. It does not run until you
resume processing.

Start Date/Time Date and time a job started, or is scheduled to
start.
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Backup Management

This sections illustrates and de�nes the �elds that are displayed on the
Backup Management screen and that you encounter when performing Backup
Management tasks.

Figure 8-7. Backup Management Screen

Field name Means this

Type Type of backup (full or partial).

Date Date that the backup was performed.

No. of Tapes Number of tapes needed to complete the
backup.

Device Tape drive on which the backup was performed.

Time Needed Time needed to complete the backup.

Files Stored Number of �les stored during the backup.
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Field name Means this

Day Day of the week a backup is scheduled.

Time Time a backup is scheduled.

Printer Printer where the backup report will be printed.

Backup Report File Name of the �le for the backup report.
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Console Management

This section illustrates and de�nes the �elds that are displayed on the
Console Management screen and that you encounter when performing Console
Management tasks.

Figure 8-8. Console Management Screen

Field Name Means this

Time Time when the system sent the message or
request.

Creator The name and logon account of the user whose
session or job created the message or request. If
a message is sent from the system, the creator
�eld is blank.

Message Messages about what is happening on the
system.

Request Requests from the system that require a
response.
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Specifying HP Easytime/iX Options

With the Options menu, you can set defaults that apply when backing up the
system, storing and restoring �les, or printing, including the following:

setting the HP Easytime/iX printer

setting store options

setting restore options

setting the backup device

The system administrator can save the option settings permanently. Unless
saved, options are valid until you exit HP Easytime/iX or change the settings
again.

Set printer option

You can access the Set Printer option from the Options menu on every
HP Easytime/iX screen.

Set Printer

Sets the default printer for all printing initiated in HP Easytime/iX, for example,
print �les, listings of system errors, or backup reports.
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Set store options

You can access Set Store Options from the Options menu on the File
Management screen. There are three options you can set for storing �les to
tape:

Save the store report on disk.

Produce an MPE V/E-compatible tape.

Store directory information with �les.

Store Report

You can specify a �le name, group, and account for the store report. This report
is saved on disk.

Produce a tape which is compatible to MPE V/E.

This option produces a tape that can be read by an MPE V/E system. This is
the previous version of your current operating system.

Store directory information.

This option creates a tape with all of the �les that you selected, as well as their
directory information (accounts, groups, and users).
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Set restore options

You can access Set Restore Options from the Options menu on the File
Management and Backup Management screens. There are �ve options you can
set for restoring �les from tape:

Save the report �le on disk.

Do not overwrite �les on disk.

Create account, groups, and users if needed.

Restore �les to your logon group and account.

Restore directory information with �les.

Restore Options

Restore Report

You can specify a �le name, group, and account for the restore report. This
report is saved on disk.

Do not overwrite files on disk.

This option prevents overwriting of �les on disk. If a �le on tape has the same
name as a �le on disk, it is not restored.
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Create accounts, groups, users as needed.

This option creates accounts, groups, and users if they are needed for the �les
being restored.

Restore files to logon group and account.

This option restores all of the selected �les to your logon group and account.

Restore directory information

This option restores directory information (accounts, groups, users) to disk,
along with the �les that you selected.
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Set backup device option

You can access the Set Backup Device option from the Options menu on the
File Management and Backup Management screens.

Set Backup Device

Sets the backup device for backups and for storing and restoring �les.

Set backup options

You can access the Set Backup Options from the Options menu on the File
Management and Backup Management screens.

Set Backup Options

You can specify a �le name, group, and account for the backup report. This
report is saved on disk.
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Understanding and Using Wildcard Characters

Wildcard characters represent groups of other characters. You can use them in
place of actual characters when specifying any of the following:

�le names

user names

account names

group names

The following wildcard characters may be used in HP Easytime/iX:

This character Represents

@ Any number of alphanumeric
characters. Alone it means \all".

? One alphanumeric character.

# One number.

Examples:

To display all �le names

File Name: @

To display all �le names beginning with �T�

File Name: T@

To display all �le names beginning with �T� followed by four numbers

File Name: T####

To display all �les for group FINANCE

File Name: @

Group: FINANCE

Account: @
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A
Preparing Additional Software Products for
Use

Setting Up Additional Software Products

Your system may have additional software products that require special set up
attention. You must do this from MANAGER.SYS. To determine if your system
has additional products, follow these steps:

1. To see if you are in MANAGER.SYS, type:

: SHOWME �Return�

d a

c b

USER: #S9749, MANAGER.SYS, PUB

RELEASE: v.uu.� MPE/iX HP31900 v.uu.�

CURRENT: Day, Month, Year, Time

LOGON: Day, Month, Year, Time

CPU SECONDS: 2 CONNECT MINUTES: 1

$STDIN LDEV: 32 $STDLIST LDEV: 32

Your screen displays information about your logon identity on the �rst line
to let you know if you are currently in MANAGER.SYS.

If you are not in MANAGER.SYS, use the HELLO command to log on as
MANAGER.SYS.

:HELLO MANAGER.SYS �Return�

2. At the system prompt (:), enter the LISTFILE command to �nd out if the
�le SPNAMES exists on your system.

:LISTFILE SPNAMES �Return�
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If no �le is found, you have not purchased any of the software that requires
special set up attention, and you can proceed to the next chapter.

3. If a �le is found, enter the following command to display the contents of the
�le to the screen. Write down the names of these products.

:PRINT SPNAMES �Return�

installing HP DeskManager

The following products need additional steps to be performed before they are
fully functional. Your Hewlett-Packard Customer Engineer (CE) will complete
the installation of these products for you. Please contact this CE for assistance.

Installing HP DeskManager

The HP DeskManager software is now installed on your system; however,
before attempting to use the product, there are some steps that must be
completed.

You must create and con�gure your databases. Refer to chapters 8 and 9 of
the HP DeskManager Administration Manual (36570-90134) for details on
how to do this.

The following UDC �les are supplied with HP DeskManager:

OPERUDC.MAILLIB.HPOFFICE - this holds the operator commands

MAILUDC.MAILLIB.HPOFFICE - this holds the user commands

The level at which these UDCs are set depends upon the guidelines followed
at your site; however, Hewlett-Packard recommends setting the operator
commands at the user level for the user MGR.HPOFFICE. To do this, enter
the following commands:

:HELLO MGR.HPOFFICE,MAILLIB

:SETCATALOG OPERUDC.MAILLIB.HPOFFICE

Remember to include all other UDCs that are to be set at the same level in
the SETCATALOG command.

The following three items may apply to your system. Please read them and
follow the instructions, if they are applicable.

A-2 Preparing Additional Software Products for Use



The American version of the product is supplied as default; however, if a
British version is to be installed, enter the following command:

:STREAM UKDICT.MAILJOB.HPOFFICE

If you are running HP DeskManager on a standalone system and Distributed
Systems (DS) or Network Services (NS) are NOT installed, enter the
following command:

:STREAM DSNSSEGS.MAILJOB.HPOFFICE

It is possible to improve the performance of HP DeskManager by
creating an Object Code Translated (OCT) version. Read the �le
OCTINSTL.MAILJOB.HPOFFICE for detailed instructions on how to
perform this translation.

Preparing Additional Software Products for Use A-3



Installing HP ALLBASE/4GL

To complete the installation of HP ALLBASE/4GL some additional steps must
be performed.

These installation procedures must be completed on a terminal other than the
system console. HP ALLBASE/4GL cannot be run on the system console.

To install new HP ALLBASE/4GL systems

To complete the installation of the HP ALLBASE/4GL Developer system or
the HP ALLBASE/4GL Run-Time Environment, perform the following steps
after the AUTOINST utility has run.

1. Create the account in which you want to use HP ALLBASE/4GL. You can
select any name for the account, but we suggest that you use the name
HP4GL for the HP ALLBASE/4GL Developer System, and HP4GLR for
the HP ALLBASE/4GL Run-Time Environment.

Developer

:HELLO MANAGER.SYS

:NEWACCT HP4GL,MGR;PASS=password;CAP=AM,AL,GL,ND,SF,BA,IA,PH

or

Run-Time

:HELLO MANAGER.SYS

:NEWACCTHP4GLR,MGR;PASS=password;CAP=AM,AL,GL,ND,SF,BA,IA,PH

2. Log on to the new account and execute the following command �le:

Developer

:HELLO MGR.HP4GL

:HP4BLD.HP4GL.SYS

or

Run-Time
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:HELLO MGR.HP4GLR

:HP4BLDR.HP4GLR.SYS

HP4BLD (or HP4BLDR) will create several groups within the account.
After the groups are created, the utility copies several �les from the SYS
account into the newly created groups.

To install the HP ALLBASE/4GL environment

The default HP ALLBASE/4GL installation assumes that the MPE/iX
system is con�gured to support the \American" language as well as the
\native computer" language. Refer to the Localizing and Customizing Systems
Information Reference Manual (32650-90046) for more information on
localization on your systems.

To run HP ALLBASE/4GL on a terminal that supports the line-drawing
character set, set the MPE/iX variable HP4TERM as follows:

:SETVAR HP4TERM "HPL"

Refer to the HP ALLBASE/4GL Developer Administration Manual
(30601-64001) or the HP ALLBASE/4GL Run-Time Administration Manual
(30602-64001) for further information on setting up the HP ALLBASE/4GL
environment.

HP ALLBASE/4GL is now ready to be run.

Installing SNA IMF/XL

You must perform some additional steps before SNA IMF/XL (HP30293) is
fully functional. Follow the steps below using the TTSINST command �le to
complete the installation. You can also access the online instructions by typing
TTSINST.PUB.SYS at the colon prompt without specifying any parameters.

To install the English language option for the United States and European sites
type the following commands:

:HELLO MANAGER.SYS

:TTSINST 000
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Con�rm that you want to complete the installation:

d a

c b

SNA IMF> Begin installing the English option (Y/N)? Y

SNA IMF> The English language option is now installed.

To install the Asian language option, type the following commands:

:HELLO MANAGER.SYS

:TTSINST

Read the instructions that appear on your screen, then enter the following:

:TTSINST 221 ** 221 is the language option parameter **

Con�rm that you want to complete the installation:

d a

c b

SNA IMF> Begin installing the Japanese option (Y/N)? Y

SNA IMF> The Japanese language option is now installed.

Installing HP Predictive Support

If you have purchased HP Predictive Support for the �rst time, your
Hewlett-Packard Customer Engineer will assist you with the installation and
supply you with the HP Predictive Support User's Guide (50779-90001).
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Installing NewWave Office Products

NewWave O�ce products include HP DeskManager, HP Resource Sharing,
and HP Information Access. Instructions for installing HP Information Access
and HP Resource Sharing are listed below. Instructions for installing HP
DeskManager are found in the beginning of this chapter.

To install HP Resource Sharing

Caution If you attempt to connect a PC to shared resources before you
complete the steps listed above, you will have to restart the
system and perform these steps again. The message \Resource
Sharing Registration Completed" must appear on the console
before you can connect a PC to shared resource.

1. License information from the NewWave O�ce Software Certi�cate must
be recorded on the system before connections to shared resources can be
allowed. You do not need to record this information again if you have
recorded it previously, and it has not changed.

If you need to update license information, or are recording it for the �rst
time, please refer to the \Installation" chapter in the NewWave O�ce
Resource Sharing for MPE XL Manual (32597-90082). The \Installation"
chapter provides the instructions for recording license information from the
software certi�cate with the NWOLC.PPC.SYS program.

2. Stream JPDINSTL.NWOCONF.HPOFFICE to complete the installation. Watch
for the console message, \Resource Sharing Registration Completed" to
verify that HP Resource Sharing is ready to receive connection requests
from PCs.

3. If you have HP Information Access, continue below.

To install HP Information Access

Please refer to the HP NewWave O�ce Information Access Server: System
Management Manual (B1716-90018) for installation instructions.
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B

Configuring Your UPS

Introducing the UPS

A new method of power failure protection is available on the HP 3000 Series
9X8 system. Instead of battery backup units, they will have one or more HP
model A2998A PowerTrust UPS (Uninterruptible Power Supply) devices.

Like the battery backup method of power failure, the UPS devices protect the
HP 3000 system against the loss of work in progress in cases of utility AC
power failures of up to �fteen minutes in duration. Furthermore, they have
been designed to appear similar to the battery backup method which minimizes
their e�ect on system operation and management procedures.

UPS devices o�er two principal advantages over the battery backup method:

In a minimal UPS-based system, the degree of power failure protection is
equivalent to that provided by the battery backup unit. You can, however,
add more UPS devices to the system and provide reserve power to selected
peripherals. Depending upon how much of the system is provided with UPS
power, it can run a partial or full workload non-stop through limited periods
of AC power failure.

The UPS contains a serial I/O communications interface that, in conjunction
with UPS Monitor/iX software, noti�es the system operator of any
problems. Like the battery backup hardware that the UPS devices replace,
a system-wide power failure recovery message is broadcast to all active user
terminals and to the console upon the return of power following a failure.
In addition to console messages, the UPS Monitor/iX software also posts a
variety of status and warning messages to the system log �les which you can
review and analyze to evaluate system performance.
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To configure a UPS device

You can use one of two con�guration methods to add UPS devices to a Series
9X8 systems. For the �rst or only UPS, which is attached to the third serial
port on the system's LAN/Console I/O interface card, you use NMMGR to
set the data precon�gured in the default con�guration group supplied with
the FOS tape. You perform this procedure once, immediately after you install
a new system. For additional UPS devices, which are attached to a DTC
serial I/O port, you use NMMGR to supply all of the information necessary
to con�gure the device(s). (As the �nal step in this second method, you will
cross-validate the con�guration �les with SYSGEN.)

Note Each UPS device, and only a UPS device, must have its
device class name set to HPUPSDEV during I/O con�guration.
Otherwise, the UPS Monitor/iX software will not be able to
initialize and communicate with the UPS device(s) correctly.

To configure the first UPS after an Install

After you have installed a new Series 9X8 system, you must \set" the UPS
con�guration data supplied in default con�guration group. To con�gure the
�rst UPS, do the following:

1. Boot the system using the default con�guration group.

2. At the MPE prompt, start the NMMGR program. Enter:

:RUN NMMGR.PUB.SYS

3. Press the
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Open Config softkey twice and wait while NMMGR opens a

con�guration �le.

4. Enter a node name and press the
NNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Save Data softkey.

5. Press the
NNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Go to DTS softkey to display the DTS con�guration screen.

6. Tab to the third �eld and enter the physical path of the LAN/Console I/O

interface card, then press the
NNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Save Data softkey.

7. Press the
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Go to UPS Port softkey and at the UPS Port screen, verify

that the LDEV number is correct, the Parity Checking option is set to
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none, and the baud rate to 1200. Make any changes to this screen if it is
necessary to correct the values.

8. Press the
NNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Save Data softkey to save your UPS Port con�guration. (Note

that the upper right corner of the screen will change from Data: N to
Data: Y.)

9. Press
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Prior Screen twice and at the Main screen, press

NNNNNNNNNNNNNNNNNNNNNNN
Utility .

10. At the Utility screen, press
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Validate Link/DTS to cross-validate the DTC

con�guration with the SYSGEN con�guration.

11. Once validation is complete, press
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Prior Screen three times and at the

Open Con�guration File screen, press
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Exit Program to exit NMMGR.

12. Reboot the system to make the new con�guration e�ective.

13. Turn power to the DTC hardware o� and then on again to download
the correct baud rate for the UPS port to the DTC hardware. (On some
systems, cycling the power to a DTC may require you to unplug it and
plug it in again.)

Note If you don't know the path of the Console/LAN interface card,
start SYSGEN's I/O con�gurator and at the io> prompt, use
the LDEV command to check the path:

io>LDEV LDEV=20

The console will be on an I/O path of the form XX/XX.0, such
as 56/56.0. The UPS device that you are con�guring will have
a path of the form XX/XX.3 (for example, 56.3). Exit the I/O
con�gurator and Sysgen and use this information in step 6.

To configure a UPS connected via a DTC port

All UPS devices on a Series 9X8 system other than the �rst one are connected
to your computer system via a DTC port. You use the NMMGR program to
add them to your system con�guration using a procedure that is very similar to
con�guring user terminals.

To con�gure a UPS connected via a DTC, do the following:

Configuring Your UPS B-3



1. At the MPE prompt, start the NMMGR program. Enter:

:RUN NMMGR.PUB.SYS

2. Press the
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Open Config softkey twice and wait while NMMGR opens a

con�guration �le.

3. Press
NNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Go to DTS to enter the DTS con�gurator.

4. Press
NNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Go to DTC and choose the appropriate DTC con�gurator for the

system (DTC16ix, DTC16MX, DTC16, DTC48, etc.).

5. Choose an available LDEV number for the UPS you are con�guring, and
determine which DTC port (DTC card number and port number) the UPS
is connected to.

6. Press the
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Config Card softkey to enter the DTC card con�gurator.

7. Add each UPS by entering its logical device number in the Ldev �eld and
UP10D12 in the Pro�le Name �eld. When you have added all UPS devices,
press

NNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Save Data

8. Press the
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Validate Link/DTS softkey to cross-validate the DTC

con�guration with the SYSGEN con�guration.

9. Once validation is complete, press
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Prior Screen until you see the Open

Con�guration File screen, and then press
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Exit Program to exit NMMGR.

If you see a message that the NETXPORT subsystem has not been
validated, ignore it and exit the program.

10. Shut down the system.

11. Turn power to the DTC hardware o� and then on again to download
the correct baud rate for the UPS port to the DTC hardware. (On some
systems, cycling the power to a DTC may require you to unplug it and
plug it in again.)

12. Reboot the system to make the new con�guration e�ective.
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Overview of UPS Monitor/iX Software

Once you have con�gured UPS devices on the system, they will automatically
be monitored by the UPS Monitor/iX software. This software causes the UPS
devices to emulate the traditional battery backup method of system powerfail
handling and recovery. UPS Monitor/iX runs continually while the system is
up to monitor all of the UPS devices for power failure and any other hardware
status conditions. It reports these conditions to the system operator via
console messages and records them in the system log �le.

Note UPS monitoring is event number 148 in the system log �les.
The default is ON (i.e. UPS hardware conditions are recorded
in the �les) regardless of whether the system has UPS power
fail protection or not. In the latter case, when no UPS devices
have been con�gured, the system log �les will receive and
record two UPS-related messages each time the system starts:
one indicating that the UPS Monitor/iX process has been
launched and a second message which says that no UPS devices
are found in the I/O con�guration.

System behavior when AC power fails

Whenever input AC power to any UPS device fails, the UPS hardware switches
to internal battery operation to continue to deliver output AC power to
the computer equipment. No actual power failure occurs at the computer
equipment itself and, as a result, the SPU continues to operate. However, the
actual behavior of the system will vary depending on how much of the system
equipment is provided with UPS power.

In the \minimal" case, where only the SPU and any Remote Busses receive
UPS power (and assuming that disks are external to the SPU), the system is
most likely to appear to be dormant (like a traditional battery backup method
system) because the system can not make progress once the disks lose power
and spin down. The system will simply enter its \idle loop", waiting for disk
I/O operations to complete, and that won't happen until AC power returns
and the disks spin up again.

But in expanded UPS coverage systems, where some or all of the disks receive
UPS power, the system may continue to run to some extent. Again, it depends

Configuring Your UPS B-5



on what resources the system needs to perform its workload. Batch jobs that
only need CPU, memory, and disk I/O can continue to run undisturbed.
Processing that requires tape or printer or terminal I/O will be blocked if those
peripherals do not have UPS power.

UPS Monitor/iX issues a warning message to the system console to notify the
operator that the particular UPS (identi�ed by its LDEV number) has reported
to the system that its input AC power has failed. In the following example,
UPS Monitor/iX reports and power failure and a recovery shortly thereafter:

d a

c b

:showtime

FRI, AUG 13, 1993, 11:27 AM

:

:11:27/50/UPS LDEV 102 reports loss of AC input power. (UPSERR 0033)

**RECOVERY FROM POWER FAIL**

11:27/50/UPS LDEV 102 reports AC input power restored. (UPSWRN 0036)

:

Example B-1. Sample Console Messages from UPS Monitor/iX

UPS Monitor/iX also writes a system log �le entry that denotes the input
power loss to the UPS device. Read ''To enable logging of UPS activity'' and
''To review UPS activity recorded in the system log �le'', later in this chapter
for more information.

System Behavior When AC Power Returns

The behavior of the system when AC input power returns to the UPS is very
similar to that of the battery backup method systems. One of two things will
happen: a recovery from power failure (if AC power returns before the UPS
battery that backs up the SPU becomes exhausted) or a system crash.

If AC power returns before the UPS battery becomes exhausted (up to �fteen
minutes when starting with fully charged UPS batteries; less if the batteries
were already partially discharged), then the system recovers from the AC power
failure and resumes normal operation. In this case, UPS Monitor/iX displays
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a message on the system console, posts an entry in the system log �les, and
broadcasts the following message to all active user terminals:

** RECOVERY FROM POWERFAIL **

If the UPS battery that powers the SPU becomes exhausted before AC input
power returns, then the system really does lose AC power and crashes. In this
case, when AC power does return and the UPS turns on again, the system
reboots just as if it used battery backup.

To enable logging of UPS activity

The UPS Monitor/iX program posts UPS status and alarm messages to the
system log �les. If system logging for the UPS Monitor/iX (which is event
number 148) is turned on, you can review the messages to troubleshoot your
system con�guration and evaluate system performance.

As the default, event 148 is ON. To verify that it is or, if necessary, to turn it
on, do the following:

1. At the MPE prompt, start SYSGEN by entering:

:SYSGEN

2. At the sysgen> prompt, start the LOG con�gurator by entering:

sysgen>LOG

3. To display which system logging events are enabled or disabled, enter:

log>SHOW SLOG

You will see a list of information similar to the example shown on the next
page.

4. To turn UPS Monitor/iX logging on (if it is currently listed as OFF), enter:

log>SLOG ON=148

5. To exit the LOG con�gurator and SYSGEN, enter the EXIT command twice.
You will see the MPE prompt displayed on your screen.
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d a

c b

log>SHOW SLOG

system log events event # status

----------------- ------- ------

System logging enabled 100 OFF

System up record 101 ON

Job initiation record 102 OFF

Job termination record 103 OFF

Process termination record 104 OFF

NM file close record 105 OFF

System shutdown record 106 ON

Power failure record 107 ON

Spooling log record 108 OFF

I/O error record 111 ON

Physical mount/dismount 112 OFF

Logical mount/dismount 113 OFF

Tape labels record 114 OFF

Console log record 115 ON

Program file event 116 ON

NCS spooling log record 120 ON

Architected interface record 130 0N

Password changes 134 ON
System logging configuration 135 ON

Restore logging 136 ON

Printer access failure 137 ON

ACD changes 138 ON

Stream initiation 139 ON

User logging 140 ON

Process creation 141 ON

Chgroup record 143 ON

Example B-2. Sample System Log Configuration
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d a

c b

File open record 144 ON

Maintenance request log 146 OFF

UPS Monitor Event Logging 148 OFF

Diagnostic Information 150 ON

High Priority Machine Check 151 ON

Low Priority Machine Check 152 ON

Directory Open/Close Logging 155 OFF

CM File Close 160 OFF

Chdir 161 OFF

Process Adoption 162 OFF

File Owner Change 163 OFF

log>

Example B-2. Sample System Log Configuration

To review UPS activity recorded in the system log file

UPS Monitor/iX status and alarm messages are recorded in the system log �les
as event number 148. You can use the LOGTOOL utility to review entries in
the system log �le about the performance and condition of UPS devices on
your system. To do so, follow these steps:

1. List the names of the log �les currently on your system. At the MPE
prompt, enter:

:LISTFILE LOG@.PUB.SYS

Note the number of the last log �le in the list (other than LOGDCC). You will
use it in step 5.

2. Start the system diagnostic utility. At the MPE prompt, enter:

:SYSDIAG

3. Run the LOGTOOL utility. Enter:

DUI >RUN LOGTOOL

4. To review the current log �le, use the SWITCHLOG command to close it and
open a new one.
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DUI >SWITCHLOG

5. List the UPS-related messages (which are recorded as system log event
number 148) in the log �le that you want to review. For example, if the last
log �le displayed with the LISTFILE command was LOG00017, enter:

DUI >LIST LOG=17;TYPE=148

Or, if the last log �le was LOG00017 and you then issued the SWITCHLOG
command, to see the most recent log �le you would enter:

DUI >LIST LOG=18;TYPE=148

In a moment, you will see the contents of the system log �les for event 148,
which stores UPS-related messages. If event 148 was disabled, you are
informed that no messages are found.
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C

UPS Console Messages

Appendix C describes console messages that only occur while you are using the
UPS.

MESSAGE: UPS LDEV! reports loss of AC input power. (UPSERR 0033)

CAUSE The speci�ed UPS device reported that it detected an input
power failure. There has been an AC power failure somewhere
in the power path leading into the UPS. The UPS has switched
to its internal battery pack to supply reserve power.

ACTION If the power failure is brief, not long enough to exhaust the
UPS battery, no action is needed. Otherwise, determine what
is causing the power loss and take action to restore the power
before the UPS battery becomes exhausted.
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MESSAGE: UPS LDEV ! reports AC input power "Bypass Mode".

(UPSWRN 0035)

CAUSE The speci�ed UPS device has been placed into its \AC Power
Bypass Mode" of operation. This should only occur when an
HP Customer Engineer is servicing the UPS and intends to put
the UPS into \Bypass Mode".

ACTION: No action is needed if this message occurs during Customer
Engineer servicing of the UPS. If this message occurs during
normal system operation, there is probably a hardware
problem in the UPS. Call your HP service representative.

MESSAGE: UPS LDEV ! reports AC input power restored. (UPSWRN

0036)

CAUSE: The speci�ed UPS device had lost its AC input power in the
past, and now the AC input power has been restored. If the
UPS is operating correctly, it will now switch from battery
operation back to normal AC power operation.

ACTION: No action is needed. The system automatically returns to
normal operation when all UPS devices (there may be one or
several UPS devices on a system) detect that normal AC input
power is present following a power loss at any UPS.

C-2 UPS Console Messages



MESSAGE: UPS LDEV ! reports "Low Battery Charge" condition.

(UPSWRN 0037)

CAUSE: The speci�ed UPS had lost its AC input power some time ago
and has been supplying reserve power from its battery. AC
input power has not been restored yet, causing the battery to
be drained down to a \low charge" power level.

ACTION: Locate and correct the cause of the AC power failure. If AC
power is not restored within the next two minutes, the UPS
battery will be exhausted and the UPS output AC power will
fail, causing power loss to the computer equipment.

MESSAGE: UPS LDEV ! reports AC output power turned off. (UPSERR

0041)

CAUSE: The speci�ed UPS device has turned o� its AC output power.
Someone may have mistakenly turned o� the UPS' power
switch, or the UPS may have malfunctioned. Whatever
equipment was receiving power from the UPS has now lost
power.

ACTION: Investigate and correct the problem at the UPS. Turn on all
power control switches on the UPS. If the computer (CPU) lost
power, you will have to re-boot the system after restoring the
UPS power.
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MESSAGE: UPS LDEV ! reports UPS "System Fail" condition cleared.

(UPSWRN 0128)

CAUSE: Some time ago, the speci�ed UPS device had reported a
UPS \System Failure" condition. Now, the \System Failure"
condition within the UPS device has been corrected and the
UPS is reporting that it has returned to normal operation.

ACTION: No action is needed. This message merely con�rms that a
previously reported problem has been corrected.

MESSAGE: UPS LDEV ! reports UPS "Inverter Fail" condition

cleared. (UPSWRN 0129)

CAUSE: Some time ago, the speci�ed UPS device had reported a UPS
\Inverter Failure" condition. Now, the \Inverter Failure"
condition within the UPS device has been corrected and the
UPS is reporting a return to normal operation.

ACTION: No action is needed. This message merely con�rms that a
previously reported problem has been corrected.
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MESSAGE: UPS LDEV ! reports UPS "Battery Not Present" condition

cleared. (UPSWRN 0130)

CAUSE: Some time ago, the speci�ed UPS device had reported a
\Battery Not Present" condition. Now, the \Battery Not
Present" condition within the UPS has been corrected and the
UPS is reporting that it has returned to normal operation.

ACTION: No action is needed. This message merely con�rms that a
previously reported problem has been corrected.

MESSAGE: UPS LDEV ! reports UPS "Charger Fault" condition

cleared. (UPSWRN 0131)

CAUSE: Some time ago, the speci�ed UPS device had reported a
UPS \Charger Fault" condition. Now, the \Charger Fault"
condition within the UPS device has been corrected and the
UPS is reporting that it has returned to normal operation.

ACTION: No action is needed. This message merely con�rms that a
previously reported problem has been corrected.
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MESSAGE: UPS LDEV ! reports UPS "Overload Shutdown" condition

cleared. (UPSWRN 0132)

CAUSE: Some time ago, the speci�ed UPS device had reported
an \Overload Shutdown" condition. Now, the \Overload
Shutdown" condition within the UPS device has been corrected
and the UPS is reporting a return to normal operation.

ACTION: No action is needed. This message merely con�rms that a
previously reported problem has been corrected.

MESSAGE: UPS LDEV ! reports UPS "High Ambient Temperature

Shutdown" condition cleared. (UPSWRN 0133)

CAUSE: Some time ago, the speci�ed UPS device had reported a \UPS
High Ambient Temperature Shutdown" condition. Now, the
\High-Ambient Temperature Shutdown" condition has been
corrected. The UPS is reporting a return to normal operation.

ACTION: No action is needed. This message merely con�rms that a
previously reported problem has been corrected.
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MESSAGE: UPS LDEV ! reports UPS "Overload" condition cleared.

(UPSWRN 0134)

CAUSE: Some time ago, the speci�ed UPS device had reported a UPS
\Overload" condition. Now, the UPS \Overload" condition has
been corrected and the UPS is reporting that it has returned to
normal operation.

ACTION: No action is needed. This message merely con�rms that a
previously reported problem has been corrected.

MESSAGE: UPS LDEV ! reports UPS "High Ambient Temperature"

condition cleared. (UPSWRN 0135)

CAUSE: Some time ago, the speci�ed UPS device had reported a UPS
\High Ambient Temp- erature" condition. Now, the \High
Ambient Temperature" condition has been corrected and the
UPS is reporting that it has returned to normal operation.

ACTION: No action is needed. This message merely con�rms that a
previously reported problem has been corrected.
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MESSAGE: UPS LDEV ! reports UPS "Battery Test Fail" condition

cleared. (UPSWRN 0136)

CAUSE: Some time ago, the speci�ed UPS device had reported a UPS
\Battery Test Fail" condition. Now, the \Battery Test Fail"
condition within the UPS device has been corrected and the
UPS is reporting a return to normal operation.

ACTION: No action is needed. This message merely con�rms that a
previously reported problem has been corrected.

MESSAGE: UPS LDEV ! reports UPS "High Battery Voltage" condition

cleared. (UPSWRN 0137)

CAUSE: Some time ago, the speci�ed UPS device had reported a UPS
\High Battery Volt- age" condition. Now, the \High Battery
Voltage" condition in the UPS device has been corrected and
the UPS is reporting a return to normal operation.

ACTION: No action is needed. This message merely con�rms that a
previously reported problem has been corrected.
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MESSAGE: UPS LDEV ! reports UPS "Low Battery Voltage" condition

cleared. (UPSWRN 0138)

CAUSE: Some time ago, the speci�ed UPS device had reported a UPS
\Low Battery Volt- age" condition. Now, the \Low Battery
Voltage" condition in the UPS device has been corrected and
the UPS is reporting a return to normal operation.

ACTION: No action is needed. This message merely con�rms that a
previously reported problem has been corrected.

MESSAGE: UPS LDEV ! reports UPS "High Output Voltage Shutdown"

condition cleared. (UPSWRN 0139)

CAUSE: Some time ago, the speci�ed UPS device had reported a UPS
\High Output Volt- age Shutdown" condition. Now, the \High
Output Voltage Shutdown" condition has been cleared and the
UPS is reporting a return to normal operation.

ACTION: No action is needed. This message merely con�rms that a
previously reported problem has been corrected.
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MESSAGE: UPS LDEV ! reports UPS "Low Output Voltage Shutdown"

condition cleared. (UPSWRN 0140)

CAUSE: Some time ago, the speci�ed UPS device had reported a UPS
\Low Output Voltage Shutdown" condition. Now, the \Low
Output Voltage Shutdown" condition has been corrected and
the UPS is reporting a return to normal operation.

ACTION: No action is needed. This message merely con�rms that a
previously reported problem has been corrected.

MESSAGE: UPS LDEV ! reports UPS "System Fail" condition. (UPSERR

0192)

CAUSE: The speci�ed UPS device reported a UPS \System Failure"
condition. This is a hardware malfunction condition within the
UPS.

ACTION: Call your Hewlett-Packard service representative.
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MESSAGE: UPS LDEV ! reports UPS "Inverter Fail" condition.

(UPSERR 0193)

CAUSE: The speci�ed UPS device reported a \UPS Inverter Fail"
condition. This is a hardware malfunction condition within
the UPS. The DC-to-AC power inverter within the UPS has
malfunctioned.

ACTION: Call your Hewlett-Packard service representative.

MESSAGE: UPS LDEV ! reports UPS "Battery Not Present" condition.

(UPSERR 0194)

CAUSE: The speci�ed UPS device reported a \Battery Not Present"
condition. This is a hardware malfunction condition within the
UPS. The UPS hardware logic perceives that the UPS battery
pack is not connected.

ACTION: Call your Hewlett-Packard service representative.
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MESSAGE: UPS LDEV ! reports UPS "Charger Fault" condition.

(UPSERR 0195)

CAUSE: The speci�ed UPS device reported a UPS \Charger Fault"
condition. This is a hardware malfunction condition within
the UPS. The UPS' internal battery charger circuitry has
malfunctioned.

ACTION: Call your Hewlett-Packard service representative.

MESSAGE: UPS LDEV ! reports UPS "Overload Shutdown" condition.

(UPSERR 0196)

CAUSE: The speci�ed UPS device reported a UPS \Overload
Shutdown" condition. Too much power was being drawn from
the UPS AC output by the computer equipment being powered
from this UPS. That equipment may be malfunctioning.

ACTION: Call your Hewlett-Packard service representative.
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MESSAGE: UPS LDEV ! reports UPS "High Ambient Temperature

Shutdown" condition. (UPSERR 0197)

CAUSE: The speci�ed UPS device reported a UPS \High Ambient
Temperature Shutdown" condition. The temperature of the
UPS hardware became too high to permit safe operation, and
the UPS turned itself o� to prevent equipment damage.

ACTION: If the computer room has become too warm, take steps to
cool the room. If room temperature is not the problem,
there has probably been a hardware malfunction. Call your
Hewlett-Packard service representative.

MESSAGE: UPS LDEV ! reports UPS "Overload" condition. (UPSERR

0198)

CAUSE: The speci�ed UPS device reported a UPS \Overload"
condition. The equipment being powered by the UPS is
drawing too much power from the UPS AC output. If the
excessive power draw continues, the UPS may reach an
\Overload Shutdown".

ACTION: Call your Hewlett-Packard service representative.
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MESSAGE: UPS LDEV ! reports UPS "High Ambient Temperature"

condition. (UPSERR 0199)

CAUSE: The speci�ed UPS device reported a UPS \High Ambient
Temperature" condition. The UPS has detected an abnormally
high temperature in the UPS hardware. If the temperature
rises further, the UPS may reach \High Temperature
Shutdown".

ACTION: If the computer room has become too warm, take steps to
cool the room. If room temperature is not the problem,
there has probably been a hardware malfunction. Call your
Hewlett-Packard service representative.

MESSAGE: UPS LDEV ! reports UPS "Battery Test Fail" condition.

(UPSERR 0200)

CAUSE: The speci�ed UPS device reported a UPS \Battery Test Fail"
condition. This is a hardware malfunction within the UPS
hardware. The UPS logic perceives that the UPS battery is
not working properly.

ACTION: Call your Hewlett-Packard service representative.
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MESSAGE: UPS LDEV ! reports UPS "High Battery Voltage" condition.

(UPSERR 0201)

CAUSE: The speci�ed UPS device reported a UPS \High Battery
Voltage" condition. This is a hardware malfunction within the
UPS hardware. The UPS logic perceives that the UPS battery
is not working properly.

ACTION: Call your Hewlett-Packard service representative.

MESSAGE: UPS LDEV ! reports UPS "Low Battery Voltage" condition.

(UPSERR 0202)

CAUSE: The speci�ed UPS device reported a UPS \Low Battery
Voltage" condition. This is a hardware malfunction within the
UPS hardware. The UPS logic perceives that the UPS battery
is not working properly.

ACTION: Call your Hewlett-Packard service representative.
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MESSAGE: UPS LDEV ! reports UPS "High Output Voltage Shutdown"

condition. (UPSERR 0203)

CAUSE: The speci�ed UPS device reported a UPS \High Output
Voltage Shutdown" condi- tion. This is a hardware malfunction
within the UPS hardware or possibly in the equipment being
powered from the UPS. The UPS has shut itself o�.

ACTION: Call your Hewlett-Packard service representative.

MESSAGE: UPS LDEV ! reports UPS "Low Output Voltage Shutdown"

condition. (UPSERR 0204)

CAUSE: The speci�ed UPS device reported a UPS \Low Output
Voltage Shutdown" condition. This is a hardware malfunction
within the UPS hardware or possibly in the equipment being
powered from the UPS. The UPS has shut itself o�.

ACTION: Call your Hewlett-Packard service representative.
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MESSAGE: UPS Monitor UPS error: Lost communications with UPS LDEV

!. That UPS is no longer being monitored. (UPSERR 0512)

CAUSE: The UPS Monitor had been monitoring the speci�ed
UPS LDEV successfully, then for some reason lost I/O
communications with that UPS. The I/O interface cable or I/O
interface hardware may have failed, or the UPS itself may have
failed.

ACTION: Check the speci�ed UPS's I/O interface cable and I/O
interface connection at the computer. Check the UPS
hardware for power connections and front panel indicators. If
the cause is not found, call your HP service representative.

MESSAGE: UPS LDEV ! I/O Operation warning: Warning status

returned by I/O system at completion of a UPS I/O

request. (UPSWRN 0533)

CAUSE: This is a software-detected warning condition that indicates
something unusual occurred in an I/O request made to a UPS
by the UPS Monitor.

ACTION: If this warning appears only rarely, then no action is needed. If
it appears frequently, then call your Hewlett-Packard service
representative.
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MESSAGE: UPS LDEV ! I/O Operation error: Error status returned by

I/O system at completion of a UPS I/O request. (UPSERR

0534)

CAUSE: This is a software-detected error condition that indicates an
error in the I/O software subsystems that the UPS Monitor
uses to communicate with UPS devices.

ACTION: If this error appears only rarely, then no action is needed. If
it appears frequently, then call your Hewlett-Packard service
representative.

MESSAGE: UPS LDEV ! I/O Operation error: A status of "aborted"

was returned by I/O system as completion status of a UPS

I/O request. (UPSERR 0535)

CAUSE: This is a software-detected error condition that indicates an
error in the I/O software subsystems that the UPS Monitor
uses to communicate with UPS devices.

ACTION: If this error appears only rarely, then no action is needed. If
it appears frequently, then call your Hewlett-Packard service
representative.
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MESSAGE: UPS LDEV ! I/O Operation error: UPS device failed to

complete a Read I/O request in allotted time. The Read

request timed out. (UPSERR 0536)

CAUSE: This is a software-detected error condition that indicates an
error in the I/O software subsystems that the UPS Monitor
uses to communicate with UPS devices. It could indicate a
disconnected I/O cable or a UPS hardware malfunction.

ACTION: Check for proper connection of the UPS I/O interface cable
at both ends. See if the UPS is powered-on. If those checks
do not reveal the source of the problem, then call your
Hewlett-Packard service representative.

MESSAGE: UPS Monitor UPS initialization: UPS LDEV ! was

initialized successfully and is now being monitored.

(UPSWRN 0540)

CAUSE: During system startup, the speci�ed UPS device was
successfully initialized by the UPS Monitor.

ACTION: No action is needed. This is merely an expected con�rmation
that the UPS and UPS Monitor software are operating
correctly.
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MESSAGE: UPS LDEV ! I/O Operation error: The actual Read data

transfer length in a UPS Read I/O operation was too

short, less than the minimum required Read transfer

length. (UPSERR 0563)

CAUSE: This is a software-detected error condition that indicates an
error in the I/O software subsystems that the UPS Monitor
uses to communicate with UPS devices. It could also indicate
an I/O interface hardware error, or a UPS hardware error

ACTION: Call your Hewlett-Packard service representative.

MESSAGE: UPS LDEV ! I/O Operation error: The actual Read data

transfer length in a UPS Read I/O operation was too

long, greater than the maximum requested Read transfer

length. (UPSERR 0564)

CAUSE: This is a software-detected error condition that indicates an
error in the I/O software subsystems that the UPS Monitor
uses to communicate with UPS devices. It could also indicate
an I/O interface error or a UPS hardware error.

ACTION: Call your Hewlett-Packard service representative.
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MESSAGE: UPS LDEV ! I/O operation error: Data supplied by the UPS

device in response to a Read I/O request did not match

any of the allowable data patterns for that request. The

Read will be re-done. (UPSERR 0567)

CAUSE: Possibly a poor I/O interface cable connection between the
system and the UPS. Possibly electrical noise interference
induced in the I/O interface cable or hardware. It could also
indicate a malfunction of the UPS hardware.

ACTION: If this error appears only rarely, then no action is needed. If
it appears frequently, then call your Hewlett-Packard service
representative.

MESSAGE: UPS LDEV ! initialization error: After trying several

times, the UPS Monitor has been unable to complete the

initialization sequence of I/O operations for this UPS

device. (UPSERR 0573)

CAUSE: Something is preventing the HP3000 system from
communicating with the UPS. Possibly a bad I/O interface
cable or bad I/O interface hardware at the system or at the
UPS. Possibly a UPS hardware malfunction.

ACTION: Check the I/O interface cable for correct attachment, and
check that the UPS is powered-on. Check that the system I/O
con�guration is correct. If the problem is not found, then call
your Hewlett-Packard service representative.
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MESSAGE: UPS Monitor warning: Too many UPS devices have been

configured in the system I/O configuration files. The

UPS Monitor can not monitor all of them; it will monitor

as many as it can. (UPSWRN 0577)

CAUSE: Incorrect system I/O con�guration. The system I/O
con�guration, generated by SYSGEN and NMMGR
con�gurators, contains more than 128 UPS devices, which
is the maximum number that the UPS monitor can handle
simultaneously.

ACTION: Review and correct the system I/O con�guration, reducing the
number of UPS devices speci�ed in the con�guration to an
acceptable number.

MESSAGE: UPS Monitor system call error: Error status ! (Subsystem

# !, Error # !) received from procedure HPFOPEN.

(UPSERR 0580)

CAUSE: This is a software-detected error condition that indicates an
error occurred in a call to the speci�ed MPE/iX operating
system procedure when that procedure was called by the UPS
Monitor software.

ACTION: Call your Hewlett-Packard service representative.
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MESSAGE: UPS Monitor system call error: Error status ! (Subsystem

# !, Error # !) received from procedure FCLOSE. (UPSERR

0581)

CAUSE: This is a software-detected error condition that indicates an
error occurred in a call to the speci�ed MPE/iX Operating
System procedure when that procedure was called by the UPS
Monitor software.

ACTION: Call your Hewlett-Packard service representative.

MESSAGE: UPS Monitor system call error: Error status ! (Subsystem

# !, Error # !) received from procedure Create_Port.

(UPSERR 0584)

CAUSE: This is a software-detected error condition that indicates an
error occurred in a call to the speci�ed MPE/iX Operating
System procedure when that procedure was called by the UPS
Monitor software.

ACTION: Call your Hewlett-Packard service representative.
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MESSAGE: UPS Monitor system call error: Error status ! (Subsystem

# !, Error # !) received from procedure Purge_Port.

(UPSERR 0585)

CAUSE: This is a software-detected error condition that indicates an
error occurred in a call to the speci�ed MPE/iX Operating
System procedure when that procedure was called by the UPS
Monitor software.

ACTION: Call your Hewlett-Packard service representative.

MESSAGE: UPS Monitor error: UPS Monitor was unable to create

its UPS Table object. The UPS Monitor process can not

operate without it, and is aborting itself. (UPSERR

0586)

CAUSE: This is a software-detected error condition that indicates an
error in the UPS Monitor software or in some other system
software, or a system memory error.

ACTION: Call your Hewlett-Packard service representative.
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MESSAGE: UPS Monitor UPS error: Unable to start monitoring on UPS

Ldev ! due to File System error in finding or opening

the device. (UPSWRN 0587)

CAUSE: This is a software-detected error condition that indicates an
error in the UPS Monitor software or in some other system
software, or a system memory error.

ACTION: Call your Hewlett-Packard service representative.

MESSAGE: UPS LDEV ! initialization error: UPS Monitor was unable

to allocate (open) this UPS device. This UPS device will

not be monitored. (UPSERR 0589)

CAUSE: This is a software-detected error condition that indicates an
error in the UPS Monitor software or in some other system
software, or a system memory error.

ACTION: Call your Hewlett-Packard service representative.
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MESSAGE: UPS Monitor error: UPS Monitor process initialization

failed due to error in obtaining resources (data object,

message port, etc.). (UPSERR 0590)

CAUSE: This is a software-detected error condition that indicates an
error in the UPS Monitor software or in some other system
software, or a system memory error.

ACTION: Call your Hewlett-Packard service representative.

MESSAGE: UPS Monitor warning: UPS Monitor finds no UPS devices

configured in the system I/O configuration files. UPS

Monitor is terminating itself. (UPSWRN 0591)

CAUSE: No UPSs have been con�gured in the system's I/O
con�guration �les. This is an error if this system is supposed
to have UPSs on it. This is not an error if this system is not
supposed to have UPS devices on it.

ACTION: If this system is supposed to have UPS devices on it, then
review and correct the system I/O con�guration, and then
restart the system. If this system is not supposed to have UPS
devices on it, then no action is needed.
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MESSAGE: UPS Monitor information: UPS Monitor process has been

launched by PROGEN and is starting-up its operation.

(UPSWRN 0595)

CAUSE: The system has just been started-up, and the UPS Monitor
software subsystem has automatically been started as well.

ACTION: No action is needed. This is merely an informational message
con�rming that the UPS Monitor software has been started.

MESSAGE: UPS Monitor information: UPS Monitor process has

initialized itself successfully, and is ready to start

UPS monitoring operations. (UPSWRN 0596)

CAUSE: After the UPS Monitor process was �rst started, it successfully
initialized itself: it acquired the basic resources it needed to
commence operations.

ACTION: No action is needed. This is merely an informational message
that con�rms that the UPS Monitor completed its process
initialization successfully.

UPS Console Messages C-27



MESSAGE: UPS Monitor information: UPS Monitor process is

shutting down, due to a normal system shutdown. (UPSWRN

0597)

CAUSE: The system operator initiated a normal Control-A Shutdown of
the MPE/iX system. The UPS Monitor is shutting itself down
as part of the overall system shutdown.

ACTION: No action is needed. This is merely an informational message
that con�rms that the UPS Monitor is shutting down due to a
normal system shutdown.

MESSAGE: UPS Monitor warning: UPS Monitor process is shutting

down and restarting itself due to an internal error

condition. (UPSWRN 0599)

CAUSE: The UPS Monitor detected an error condition internal to its
software, and is attempting to recover by restarting itself from
the beginning of its process.

ACTION: If this warning appears only rarely, then no action is needed.
If it appears frequently, then call your Hewlett-Packard
representative.
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MESSAGE: UPS Monitor error: UPS Monitor process is shutting

down, due to an unrecoverable internal error condition.

(UPSERR 0600)

CAUSE: The UPS Monitor software detected an error condition within
its processing from which it can not recover. Accordingly, it is
shutting itself down, ending the UPS monitoring processing.

ACTION: This should rarely, if ever, happen in practice. You can re-boot
the system to see if the UPS Monitor will run successfully after
a new startup of the system. If the problem persists, call your
Hewlett-Packard service representative.

MESSAGE: UPS Monitor information: UPS Monitor process startup of

UPS devices failed, due to inability to get UPS devices'

allocation information from the system. (UPSERR 0602)

CAUSE: This is a software-detected error condition that indicates an
error in the UPS Monitor software or in some other system
software, or a system memory error.

ACTION: Call your Hewlett-Packard service representative.
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4-20
changing ports
using NMMGR, 4-20

choosing options in dialog boxes, 6-21
cleaning of tape head
how, 5-13
when, 5-13

closing
dialog boxes, 6-21
menus, 6-14

commands
MPE/iX, 1-2

computer peripherals
console, 3-1
external disk drive, 3-3

con�guration
changing using NMMGR, 4-20
cross-validate, 4-23
DTC, 4-14
performing a �nal validation, 4-23

con�guring
UPS, 3-11

con�guring databases
HP DeskManager, A-2

con�guring software
using NMMGR, 4-20

console, 3-1
Console Management screen
�elds, 8-24{29
tasks, 7-56{60

console messages
creator, 8-24
requests, 8-24
responding to messages, 8-5{7
responding to requests, 8-3{4
time sent, 8-24
UPS, 3-11

console messages and requests, 8-2{7,
8-24

displaying, 7-59
printing, 7-59
replying, 7-58
resetting the view, 7-60
viewing, 7-56

conventions
menus, 6-15
used in documentation, 1-4

copy data
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from disk to tape, 5-11
from tape to disk, 5-10
using RESTORE command, 5-10
using STORE command, 5-11

copy data from disk, 5-11
copy data from tape, 5-10
copy �les to tape, 5-11
copying
�les, 7-9{17
�les from disk to tape, 7-11
�les from tape to disk, 7-14
�les to another group, 7-9

correcting
typing errors, 6-20

cursor movement keys, 8-8
customizing, 4-19
customizing HP Easytime/iX, 7-60{66

D

data communications and terminal
controller, 3-5

DDS
digital data storage, 5-1

DDS tape drive
operating, 5-3

default baud rate
printers, 4-20
terminals, 4-20

defaults
set backup device, 8-29
set backup options, 8-29
set printer, 8-25
set restore options, 8-27{28
set store options, 8-26

deleting
�les, 7-17
jobs, 7-40
print �les, 7-26
sessions, 7-4

devices
backup, 8-22

dialog boxes
canceling, 6-21
choosing options, 6-21
closing, 6-21
correcting typing errors, 6-20
moving around in, 6-21
typing information, 6-20

digital data storage (DDS), 5-1
disabling
HP Easytime/iX, 6-3

disk drive
external, 3-3

displaying
console messages and requests, 7-59
�les, 7-21
jobs, 7-45
print �les, 7-30
sessions, 7-5

drive
tape, 2-5

DTC 16iX, 3-5
DTC con�guration, 4-14

E

Easytime/iX
what is it?, 1-1

editing
text, 8-9

enabling
HP Easytime/iX, 6-2
printers, 7-34

English language option
SNA IMF/XL, A-5

exiting
HP Easytime/iX, 6-6
HP Easytime/iX Setup, 7-66

external disk drive, 3-3
external disk drives
adding, 4-3
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F

�eld de�nitions, 8-12{24
�eld help, 6-9
�le
using SPNAMES, A-2

File Management screen
�elds, 8-14{15
tasks, 7-7{22

�les, 8-14{15
account, 8-15
adding MPE/iX security, 7-21
code, 8-15
copying, 7-9
deleting, 7-17
�le name, 8-14
group, 8-14
moving, 7-18{20
printing, 7-9
reading, 7-20
removing MPE/iX security, 7-20
renaming, 7-17
resetting the view, 7-22
setting restore options, 7-16
setting store options, 7-13
size, 8-15
sorting, 7-22
status, 8-15
stored during backup, 8-22
verifying �les restored, 7-16
verifying �les stored, 7-13
viewing, 7-8

�nal validation
con�guration, 4-23
using SYSGEN, 4-23

function keys, 8-10{11
Add to List, 8-10
Cancel, 8-10
Close, 8-10
Delete from List, 8-10
Fast Select, 8-10
Field Help, 8-10

Read, 8-10
Read Next, 8-11
Save, 8-11
Select, 8-11
Stop, 8-11
Test, 8-11
To/From Menu Bar, 8-11
Update Display, 8-11

G

general information, 1-1
getting help, 6-7{9
from Main menu, 6-10
Help menu, 6-7

getting started, 6-1{23
Go to MPE, 6-6
groups
on �le screen, 8-14

H

handling cassettes, 5-10, 5-11
hardware
listing, 4-1
overview, 2-1

help
menu, 6-7
menu, opening, 6-7
on basic skills, 6-7
on glossary, 6-7
on help, 6-7
on keys, 6-7
on procedures, 6-7
on version, 6-7

Help key, 6-9
Help menu topics
reading, 6-8

holding jobs, 7-42
HP ALLBASE/4GL
American language, A-5
installing, A-4
installing developer system, A-4
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installing run-time environment, A-4
line-drawing character set, A-5
native computer language, A-5

HP DeskManager
American version, A-2
British version, A-2
con�guring databases, A-2
installing, A-2
Object Code Translated version, A-3
standalone, A-3
UDC �les, A-2

HP Easytime/iX
disabling, 6-3
enabling, 6-2
installing, 6-2
moving around in, 8-8
options, 8-25{29
reference, 8-1{30
tasks, 7-1{68
troubleshooting, 7-66, 7-68
what is it?, 1-1

HP Information Access
installing, A-7
NewWave, A-7

HP Predictive Support, A-6
HP Resource Sharing
installing, A-7
NewWave, A-7

I

identifying
user input, 1-4

indicator lights
UPS, 3-7

indicator status lights
interpreting, 2-6

installing
HP ALLBASE/4GL, A-4
HP DeskManager, A-2
HP Information Access, A-7
HP Resource Sharing, A-7

NewWave, A-7
SNA IMF/XL, A-5

installing developer system
HP ALLBASE/4GL, A-4

installing HP Easytime/iX, 6-2
installing run-time environment
HP ALLBASE/4GL, A-4

interpreting status lights, 5-7
ISL
starting your system from, 4-2

ISL prompt, 4-2

J

jobfence
setting, 7-45

Job Management screen
�elds, 8-20{21
tasks, 7-37{47

jobs, 8-20{21
account, 8-20
deleting, 7-40
displaying, 7-45
job name, 8-20
limiting number of, 7-44
moving to top of queue, 7-43
program, 8-20
putting on hold, 7-42
resetting the view, 7-46
resuming suspended jobs, 7-43
scheduling, 7-41
setting the jobfence, 7-45
sorting, 7-46
starting, 7-39
status, 8-21
suspending, 7-42
taking o� hold, 7-42
user, 8-20
viewing, 7-38

K

keys, 8-8{11

Index-5



cursor movement, 8-8
editing, 8-9
function, 8-10{11
selecting items, 8-9

L

labeling a cassette, 5-6
LDEVs
removing, 4-5

limiting
jobs, 7-44
sessions, 7-5

line-drawing character set
HP ALLBASE/4GL, A-5

list box, 6-12
identifying, 6-16
scrolling in, 6-17
selecting objects, 6-17

listing system hardware, 4-1
MAPPER, 4-1

loading your cassette, 5-2
logging on, 6-4

M

Main menu
getting help, 6-10
opening a screen, 6-10

maintaining
tape drive, 5-1

managing
backups, 7-47
console messages, 7-56
�les, 7-7
jobs, 7-37
printers, 7-32
print �les, 7-22
sessions, 7-2

MAPPER
listing system hardware, 4-1

menu bar, 6-11
menus

choosing menu items, 6-14
closing, 6-14
conventions, 6-15
opening, 6-13

message line, 6-12
messages
and requests from the system, 8-2{7
sending to other users, 7-4

modes, 6-22{23
moving
�les, 7-18{20
�les multiple �les, 7-19
�les one �le, 7-18
in HP Easytime/iX, 8-8
jobs to top of queue, 7-43
print �les to top of queue, 7-26

MPE/iX commands
what are they?, 1-2

N

native computer language
HP ALLBASE/4GL, A-5

NewWave
HP Information Access, A-7
HP Resource Sharing, A-7
installing, A-7

NMMGR
changing ports, 4-20
con�guring the software, 4-20
for changing con�guration, 4-20

O

Object Code Translated version
HP DeskManager, A-3

online Help Facility, 1-3
opening
menus, 6-13
screens, 6-10

operating
DDS tape drive, 5-3

operating modes, 6-22{23
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changing administrator password,
6-23

changing to system administrator,
6-22

changing to user, 6-23
operating system
adding external drives to, 4-3
removing LDEVs, 4-5

options, 7-13, 8-25{29
set backup device, 8-29
set backup options, 8-29
set printer, 8-25
set restore options, 8-27{28
set store options, 8-26

ordering
HP DDS cassettes, 5-2

overview
hardware, 2-1

P

passwords
changing administrator's, 6-23
setting administrator's, 6-22

performing a full backup, 7-52
peripherals
console, 3-1
external disk drive, 3-3

practicing basic skills, 6-24{27
preparing a cassette, 5-4
printer
status checking, 4-20

printer con�guration
changing, 4-19, 4-20
default, 4-19

Printer Management screen
�elds, 8-18{19
tasks, 7-32, 7-36

printers, 8-18{19
adding, 4-20
checking the status, 7-34
default baud rate, 4-20

disabled, 8-18
disabling, 7-34
enabled, 8-18
enabling, 7-34
options, 8-25
outfence, 8-19
printer name, 8-18
setting the HP Easytime/iX printer,

7-35
setting the outfence, 7-35
setting up, 4-9
status, 8-18
viewing, 7-33

Print File Management screen
�elds, 8-16{17
tasks, 7-23�

print �les, 8-16{17
account, 8-16
aligning forms, 7-30
changing number of copies, 7-27
changing printer, 7-28
deleting, 7-26
displaying, 7-30
loading forms for, 7-29
moving to top of queue, 7-26
printer, 8-16
print �le name, 8-16
putting on hold, 7-26
reading the contents, 7-27
reprinting, 7-29
resetting the view, 7-31
sorting, 7-32
status, 8-17
taking o� hold, 7-26
user, 8-16
viewing, 7-24

printing
conventions, 1-4
�les, 7-9
messages and requests, 7-59

problems, 7-66, 7-68
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programs
jobs running, 8-20
sessions running, 8-13

prompt
ISL, 4-2

Q

queue
moving a job to the top, 7-43
moving print �les to top, 7-26

quick reference cards, 1-3

R

reading �les, 7-20
Read Next function key, 8-11
ready jobs, 8-21
rebooting
DTC, 4-18
system, 4-18

removing
LDEVs, 4-5

renaming �les, 7-17
replying
to messages from other users, 7-4
to system requests, 7-58

requests
and messages from the system, 8-2{7
console messages, 8-24
from the system, 8-2{7

RESTORE command
to copy data, 5-10

restore options, 8-27{28
restoring
�les from tape to disk, 7-14

restricting
number of jobs, 7-44
number of sessions, 7-5
printing, 7-34

resuming
jobs, 7-43

S

Save, 8-11
scheduled jobs, 8-21
scheduling
backups, 7-50
jobs, 7-41

screens
identifying, 6-11
opening, 6-10

scrolling, 8-8
in list boxes, 6-17

securing �les, 7-21
security
with MPE/iX, 7-21

Select, 8-11
selecting, 6-17{18
all items, 6-18
a range of items, 6-18
items, 8-9
multiple items, 6-17
one item, 6-17

sending
messages to other users, 7-4

Session Management screen
�elds, 8-13
tasks, 7-2{7

sessions, 8-13
account, 8-13
deleting, 7-4
displaying, 7-5
limiting number of, 7-5
name, 8-13
program, 8-13
resetting the view, 7-6
sending messages to other users, 7-4
sorting, 7-6
start date/time, 8-13
user, 8-13
viewing, 7-2

setting
backup device, 7-56

Index-8



backup options, 7-54
HP Easytime/iX printer, 7-35
jobfence, 7-45
job limit, 7-44
printer outfence, 7-35
restore options, 7-16
session limit, 7-5
store options, 7-13
the administrator password, 6-22

setting up
additional software products, A-2
printers, 4-9
terminals, 4-9

setup program
canceling a startup screen, 7-65
choosing a startup screen, 7-65
disabling functions, 7-62
enabling functions, 7-63
exiting, 7-66
saving the setup, 7-65
setting backup defaults, 7-63
setting console, 7-64
starting, 7-61

SNA IMF/XL
Asian language option, A-6
English language option, A-5
installing, A-5

solving problems, 7-66, 7-68
printer problems, 7-67
print �le problems, 7-66

sorting
�les, 7-22
jobs, 7-46
print �les, 7-32
sessions, 7-6

SPNAMES �le, A-2
standalone
HP DeskManager, A-3

starting
backups, 7-52
HP Easytime/iX, 6-5

jobs, 7-39
printers, 7-34

starting system
using START NORECOVERY, 4-25

starting your system, 4-2, 4-26
status
�les, 8-15
job, 8-21

status lights
interpreting, 5-7
interpreting a caution, 5-8
interpreting for read-only, 5-8
tape drive, 2-6

status line, 6-11
Stop, 8-11
stopping
backups, 7-54
jobs, 7-40
printers, 7-34

store options, 8-26
storing
�les to tape, 7-11

storing cassettes, 5-10, 5-11
streaming jobs, 7-39
suspended
jobs, 8-21

suspending
jobs, 7-42

switches
UPS, 3-7

SYSGEN
performing a �nal validation, 4-23

system
booting, 4-26
external disk drives, 4-3
rebooting, 4-18
starting, 4-2

system administrator mode, 6-22
system hardware
listing, 4-1
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T

tape cassettes, 5-2
tape drive, 2-5
maintaining, 5-1
operating, 5-3
preparing a cassette, 5-4
status lights, 2-6
using, 5-1

tape drives, 5-1
descriptions, 5-1
familiarization , 5-1
indicators, 5-1

tapes
cleaning of tape head, 5-13

tasks in HP Easytime/iX, 7-1{68
temperature guidelines
cassettes, 5-12

terminal con�guration
changing, 4-19, 4-20
default, 4-19

terminals
adding, 4-20
default baud rate, 4-20
setting up, 4-9

text, editing, 8-9
title bar, 6-11
To/From Menu Bar key, 8-11

troubleshooting, 7-66
typing in a �eld, 6-20

U

UDC �les
HP DeskManager, A-2

Understanding Your System, 1-3
uninterruptible power supply
UPS, 3-7

unloading your cassette, 5-6
Update display key, 8-11
UPS
con�guring, 3-11
console messages, 3-11
indicator lights, 3-7
switches, 3-7
uninterruptible power supply, 3-7

user mode, 6-22
users
on job screen, 8-20
on print �le screen, 8-16
on session screen, 8-13

using
tape drive, 5-1

W

wildcard characters, 8-30
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